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ดัชนีความแห้งแล้งคือดัชนีท่ีบ่งบอกความแห้งแล้งของพืน้ท่ี ได้จากการน าปัจจัยท่ีมี
อิทธิพลส่งผลต่อความแห้งแล้งในพืน้ท่ีนัน้ ในการศึกษาเลือกสามดชันีคือ Normalized Monthly 
Precipitation Anomaly Percentage (NPA), Vegetation Health Index (VHI) และ  Normalized 
Vegetation Supply Water Index (NVSWI)และไ ด้ ใ ช้ ข้อมูล  TRMM3B42 V.7 จากดาว เ ทียม 
TRMM เข้ามาช่วยประเมินความถูกต้องความเหมาะสมของดชันีภัยแล้งกับพืน้ท่ีศึกษาคือลุ่มน า้
นา่น โดยระยะเวลาท่ีใช้ในการศกึษาคือสิบปี(ปี พ.ศ 2551- ปี พ.ศ 2560) โดยได้มีการน าข้อมลูฝน
จากสถานีฝนในลุ่มน า้น่านและข้อมูลผลิตภัณฑ์ TRMM3B42 V.7 มาตรวจสอบก่อนเพ่ือตรวจดู
ลกัษณะฝนในพืน้ท่ีลุม่น า้นา่นเพ่ือง่ายตอ่การวิเคราะห์ 

ผลการศกึษาพบว่าดชันี NVSWI มีความเหมาะสมโดยวิเคราะห์จากความสมัพนัธ์ของดชันี
ความแห้งแล้งกบัผลิตภณัฑ์ TRMM3B42 โดยมีการพิจารณาถึงพืน้ท่ีชลประทานซึ่งถกูต้องส าหรับ
การตรวจสอบความแห้งแล้ง ส่วนดชันี VHI มีค่าสหสมัพนัธ์เท่ากับ -0.311 แต่มีความสมัพนัธ์เชิง
ลบ การวิเคราะห์เชิงพืน้ท่ีผลท่ีได้ก็มีความรุนแรงเกินจริงขดัแย้งกบัข้อมลูจากชลประทานเน่ืองจาก
ข้อมูลของอุณหภูมิของผิวดินท่ีสงู และดชันี NPA จะน าปัจจยัในเร่ืองปริมาณน า้ฝนเข้ามาช่วยใน
การตรวจสอบความแห้งแล้งและมีค่าสัมประสิทธ์ิสหสัมพันธ์เท่ากับ 0.299 แต่เน่ืองจากดชันีไม่
สามารถหาการกระจายเชิงพืน้ท่ีได้ จึงได้ผลสรุปว่า ดชันีท่ีดีท่ีสุดในสามตวัท่ีเหมาะกับพืน้ท่ีลุ่มน า้
นา่น คือ ดชันี NVSWI 
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ABSTRACT 
Drought index is an indicator of drought in the area. The factors that influence the 

drought in that area. In the study, three indices were selected: Normalized Monthly 
Precipitation Anomaly Percentage (NPA), Vegetation Health Index (VHI) and Normalized 
Vegetation Supply Water Index (NVSWI), and TRMM3B42 V.7 data from TRMM satellites. 
The drought index of the study area is Nan River Basin. The duration of the study is ten 
years (2008 - 2017). The rainfall data from the rain station in the Nan Basin and the 
TRMM3B42 V.7 information was provided for review. Rainfall in the Nan Basin for easy 
analysis. 

The results show that the NVSWI index is appropriate by analyzing the relationship 
between the drought index and the TRMM3B42 product. The correct area for drought 
monitoring is considered. The VHI has a correlation coefficient of -0.311. Negative 
relationship Spatial analysis of the results has been severely exaggerated, conflicting with 
irrigation data due to high surface temperature data and the NPA index has led to 
precipitation and drought. The correlation coefficient is 0.299, but the index can not find 
spatial distribution. I have concluded that. The three best indexes suitable for the Nan 
Basin are the NVSWI 
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บทที่1 
บทน า 

1.1 ที่มาและความส าคัญ 

ภยัแล้งนัน้เป็นปรากฏการณ์ท่ีใช้ระยะเวลาในการท่ีจะทราบถึงผลกระทบท่ีเกิดขึน้ ผลกระทบท่ี

เกิดขึน้นัน้อาจส่งผลกระทบเป็นเวลานานโดยจะเร่ิมส่งผลจากกการรุกคืบเข้ามาอยา่ช้าๆ ไม่เหมือน

ปรากฏการณ์อ่ืนท่ีรับรู้ผลกระทบอย่างรวดเร็ว เช่นปรากฏการณ์น า้ท่วมสามารถเห็นผลกระทบท่ี

เกิดขึน้ได้อย่างทนัทีว่ามีปริมาณน า้ท่ีเพิ่มสูงขึน้ โดยความแห้งแล้งนัน้แบ่งออกเป็น 1) ความแห้ง

แล้งทางอตุนุิยม เกิดจากสภาพฝนทิง้ช่วงหรือฝนตกน้อยกว่าระดบัท่ีก าหนด 2) ความแห้งแล้งทาง

เกษตรกรรม ท่ีเกิดจาการท่ีน า้ในดินมีน้อยขาดความชุ่มชืน้ส่งผลต่อการเจริญเติบโตของพืช           

3) ความแห้งแล้งทางอทุกวิทยา ท่ีสงัเกตดรูะดบัน า้ใต้ดินและระดบับนผิวดิน ระดบัน า้ในแม่น า้ล า

คลอง 4) ความแห้งแล้งทางเศรษฐศาสตร์และสงัคม ท่ีจะค านึงถึงทรัพยากร เช่นการขาดแคลนพืช

มีอิทธิผลต่อราคาอาหาร ท าให้เกิดความไม่สงบทางการเมืองอันเน่ืองมาจากการขาดแคลน

ทรัพยากร  

ดชันีความแห้งแล้งคือดชันีท่ีบ่งบอกความแห้งแล้งของพืน้ท่ี ได้จากการน าปัจจยัท่ีมีอิทธิพล

สง่ผลตอ่ความแห้งแล้งในพืน้ท่ีนัน้ การขาดแคลนและลดลงของความชืน้โดยดชันีความแห้งแล้งนัน้

ถูกพัฒนาและปรับเปล่ียนตามตัวแปรต่างๆท่ีน ามาช่วยค านวณ การประยุกต์น าเอาข้อมูล

ผลิตภณัฑ์ดาวเทียมมาช่วยประเมินหาความแห้งแล้งจะเป็นการช่วยเพิ่มความถูกต้องและแม่นย า

มากขึน้เห็นได้จากหลายประเทศได้มีการใช้การส ารวจระยะไกลมาช่วยเป็นเคร่ืองมือในการประเมิน

ความแห้งแล้งเห็นได้จากงานวิจยัของ (Wang et al. (2014), Cong et al. (2016) ท่ีแสดงให้เห็นว่า

การน าเทคโนโลยีการส ารวจระยะไกลและข้อมูลดาวเทียมมาช่วยในการตรวจสอบความแห้งแล้ง

นัน้ดีทัง้ในด้านเวลาและการติดตามเชิงพืน้ท่ี เพราะสามารถติดตามรูปแบบความแห้งแล้ งทัง้ยัง

สามารถรับข้อมลูท่ีมีความทนัสมยัเป็นปัจจบุนัสามารถน ามาตรวจสอบได้ 

จากข้อมลูส านกังานทรัพยากรน า้ภาค9ได้อธิบายวา่ลุ่มน า้นา่นเป็นลุ่มน า้หลกัในภาคเหนือของ

ประเทศไทย โดยลุม่น า้นา่นได้ครอบคลมุบางสว่นของ5จงัหวดัคือ จงัหวดันา่น  อตุรดติถ์  พิษณโุลก  

พิจิตร และนครสวรรค์ ในสาขาลุ่มแม่น า้น่านตอนล่างนิยมท าการเกษตรมากโดยเฉพาะพืน้ท่ี

จังหวัดพิจิตรและจังหวัดพิษณุโลก โดยในประชากรบริเวณลุ่มน า้มีประมาณ 2.15 ล้านคนในปี

2547 แม่น า้ในลุ่มน า้น่านบางส่วนจะไหลลงผ่านหุบเขาลงสู่อ่างเก็บน า้สิริกิติ์ แม่น า้ในลุ่มน า้น่าน
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นัน้มีความส าคัญต่อผู้คนท่ีด ารงชีวิตอยู่ไม่ว่าจะน าไปอุปโภคหรือบริโภคร่วมถึงการน าไปใช้ใน

การเกษตร   น า้นัน้ส าคญัต้องรู้จกัวางแผนการใช้น า้ให้ดีเพราะถึงแม้ว่าจะมีแม่น า้หลายสายแต่

หลายพืน้ท่ีของลุม่น า้นา่นก็ยงัประสบกบัปัญหาภยัแล้งอยู่ 

การศกึษาครัง้นีจ้งึมีวตัถปุระสงค์ท่ีจะท าการประเมินความถกูต้องของดชันีภยัแล้งโดยน าข้อมลู

ฝนจากผลิตภณัฑ์ TRMM3B42 V.7 ท่ีได้จากดาวเทียม TRMM มาช่วยตรวจสอบเพ่ือความถกูต้อง

และแมน่ย ามากขึน้ของข้อมลูและหาดชันีภยัแล้งท่ีเหมาะสมกบัพืน้ท่ีลุม่น า้นา่นประเทศไทยเพ่ือให้

การวางแผนรับมือภัยแล้งมีประสิทธิภาพมากขึน้ และดแูนวโน้มการเปล่ียนแปลงเพ่ือคาดการภัย

แล้งท่ีจะเกิดขึน้ในอนาคต 

 

1.2 วัตถุประสงค์ของการวิจัย 

1)  เพ่ือประเมินความถูกต้องดชันีภัยแล้งและหาดชันีภยัแล้งท่ีเหมาะสมกับพืน้ท่ีในศกึษาลุ่ม

น า้นา่น 

2) เพ่ือศกึษาแนวโน้มความแห้งแล้งท่ีเกิดขึน้ภายในลุม่น า้น่านเพ่ือคาดการณ์ความแห้งแล้งใน

อนาคต 

 

1.3 ความส าคัญของการวิจัย 

 ดัชนีภัยแล้ง คือ ดัชนีท่ีมีความสัมพันธ์กับปัจจัยท่ีมีผลกระทบสะสมเกิดขึน้เป็นระยะ

เวลานานและมีความผิดปกติของความชืน้ การขาดแคลนและลดลงของความชืน้โดยดชันีความ

แห้งแล้งนัน้ถกูพฒันาและปรับเปล่ียนตามตวัแปรตา่งๆท่ีน ามาชว่ยค านวณ จงึท าให้มีดชันีภยัแล้งท่ี

หลากหลายในการใช้หาภยัแล้ง การหาดชันีภัยแล้งท่ีเหมาะสมกบัพืน้ท่ีศึกษาจึงจ าเป็นและเพ่ือท่ี

ได้มาซึ่งผลท่ีถูกต้องการประเมินความถูกต้องของดัชนีภัยแล้งจึงส าคัญ  จึงได้มีการน าข้อมูล

ผลิตภณัฑ์ TRMM3B42 V.7 จากดาวเทียม TRMM เข้ามาช่วยตรวจสอบหาความถกูต้องของดชันี

ภยัแล้ง 

 

1.4 ขอบเขตของการวิจัย 
1.4.1 ขอบเขตด้านพืน้ท่ี 
ลุม่น า้น่านตัง้อยูท่างภาคเหนือของประเทศไทย ครอบคลมุพืน้ท่ี 5 จงัหวดัได้แก่ น่าน อตุรดิตถ์ 

พิจิตร พิษณุโลก นครสวรรค์ มีพืน้ท่ีประมาณ 31,654.34 ตารางกิโลเมตร มีปริมาณฝนเฉล่ีย1,041 
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มิลลิเมตร/ปี โดยแม่น า้น่านมีต้นก าเนิดจากเทือกเขาหลวงพระบาง ซึ่งเป็นเส้นแบง่เขตแดนไทย - 

ลาว  ลกัษณะของลุม่น า้วางแนวทิศเหนือใต้ 

- ทิศเหนือตดิกบัลุม่น า้โขง   

- ทิศใต้ตดิกบัลุม่น า้เจ้าพระยา   

- ทิศตะวนัออกตดิกบัลุม่น า้โขงและลุม่น า้ป่าสกั  

- ทิศตะวนัตกตดิกบัล าน า้นา่น 

1.4.2 ขอบเขตด้านเนือ้หาและเวลา 

การศกึษาครัง้นีเ้ป็นการประเมินดชันีภยัแล้งในลุ่มน า้นา่นโดยใช้ข้อมลูผลิตภณัฑ์ TRMM3B42 

V.7 จากดาวเทียมTRMMมาช่วยในการตรวจสอบดชันีภัยแล้งโดยการดูความสมัพนัธ์ของข้อมูล

TRMM3B42กับดชันีทัง้สาม ในพืน้ท่ีศึกษาห้าจังหวัดลุ่มน า้น่าน ในช่วงระยะเวลา ปี พ.ศ.2551-

พ.ศ.2560 โดยดชันีภัยแล้งท่ีใช้ในการศึกษานีมี้สามดชันีคือ Normalized Monthly Precipitation 

Anomaly Percentage (NPA), Vegetation Health Index (VHI) และ  Normalized Vegetation 

Supply Water Index (NVSWI) 

 

1.5 ข้อตกลงเบือ้งต้น 

การศึกษาครัง้นีใ้ช้ผลิตภัณฑ์จากดาวเทียม  MODIS โดยใช้ผลิตภัณฑ์ MOD11C3 และ

MOD13C2 ท่ีดาวโหลดทางเว็บไซด์ท่ีให้บริการท่ี https://search.earthdata.nasa.gov/search 

และใช้ข้อมูลผลิตภัณฑ์ฝนจาก TRMM3B42 V.7 จากดาวเทียม TRMM ดาวโหลดทางเว็บไซด์

https://mirador.gsfc.nasa.gov/ 
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ภาพ 1.1 แผนที่ขอบเขตพืน้ท่ีศึกษา 

1.6 นิยามศัพท์เฉพาะ 

Tropical Rainfall Measuring Mission (TRMM) คือการวัดปริมาณน า้ฝนแบบเขตร้อน เป็น

ภารกิจร่วมกันระหว่าง NASA และองค์การพัฒนาพืน้ท่ีแห่งชาติของประเทศญ่ีปุ่ น (NASDA) ซึ่ง

ออกแบบมาเพ่ือตรวจสอบและศึกษาปริมาณฝนในเขตร้อนและการปลดปล่อยพลังงานท่ี

เก่ียวข้องซึ่ขงจะช่วยให้การไหลเวียนของบรรยากาศในอากาศเป็นไปอย่างทัว่ถึง สภาพภูมิอากาศ

ทัว่โลก 

ข้อมูลปริมาณน า้ฝนจากสถานีตรวจวัดฝน คือข้อมลูปริมาณน า้ฝนท่ีได้รับมาจากปี    พ.ศ.

2551 ถึงปี พ.ศ.2560 จากระบบบริการข้อมูลทางอุตุนิยมวิทยา (https://www.tmd.go.th/) เพ่ือ

ตรวจสอบขอมลู TRMM 3B42 รายเดือน ข้อมลูในลุ่มน า้น่านซึ่งเป็นค่าเฉล่ียรายเดือนของข้อมลูท่ี

รวบรวมได้จากสถานีอตุนุิยมวิทยา ภายในลุม่น า้นา่นในและพืน้ท่ีโดยรอบน ามาเฉล่ียเป็นรายเดือน 
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ด า ว เ ที ย ม ร ะ บ บ  MODIS คื อ  ร ะ บ บ  MODIS (Moderate Resolution Imaging 

Spectroradiometer ) เป็น 1 ใน 5 ระบบเซนเซอร์ท่ีติดตัง้บนดาวเทียม Terra และ Aqua เป็น

ดาวเทียมในกลุม่ดาวเทียมส ารวจโลก ทัง้สองดวงมีวงโคจรอยูท่ี่ระดบั 705 กิโลเมตร ระบบ MODIS 

มี 36 แบนด์ ตัง้แตค่วามยาวคล่ืน 0.4 ถึง 14.4 ไมครอน มีขนาดความละเอียดเชิงพืน้ท่ีแตกตา่งกนั

สามระดบัคือ ท่ีขนาด 250 เมตร (แบนด์ 1 และ 2) ขนาด 500 เมตร (แบนด์ 3 – 7) และขนาด 1 

กิโลเมตร (29 แบนด์ท่ีเหลือ) ดาวเทียมระบบ MODIS จดัว่าเป็นอีกระบบหนึ่งท่ีสามารถใช้จดัท า

อนพุนัธ์ภาพท่ีใช้ท าดชันีความแห้งแล้งได้ 

ภัยแล้ง คือ ความแห้งแล้งของลมฟ้าอากาศ สาเหตจุากการท่ีมีฝนตกน้อยกวา่ปกติ หรือฝนไม่

ตกต้องตามฤดกูาล เป็นระยะเวลานานกวา่ปกติและครอบคลมุพืน้ท่ีบริเวณกว้างท าให้เกิดการขาด

แคลนน า้ 

ข้อมูลการใช้ประโยชน์ท่ีดิน คือ ข้อมูลท่ีแสดงถึงสิ่งท่ีปกคลมุพืน้ผิว ข้อมลูได้จากกรมท่ีดิน

โดยถกูน ามาใช้เพ่ือให้ได้ประเภทของพืชคลมุหลกัแตล่ะโซนพืน้ท่ี 

 

1.7 สมมตฐิานของการวิจัย 

1) ดชันีภยัแล้งแตล่ะดชันีให้ผลท่ีไมเ่หมือนกนั จงึต้องหาดชันีท่ีเหมาะสมกบัพืน้ท่ี 

2) ลุม่น า้นา่นมีแนวโน้มของภยัแล้งเพิ่มสงูขึน้ 
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1.8 กรอบแนวคิดการวิจัย 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพ 1.2  กรอบแนวคิดการวิจัย 

MOD11c3 

 c 

MOD13c2 

NDVI 

  

การประเมินความถกูต้องของดชันีความแห้งแล้งโดยหา

ความสมัพนัธ์จากข้อมลู TRMM3B42 กบัดชันีทัง้สาม 

โด 

 

การเปล่ียนแปลงความแห้งแล้ง การกระจายของความแห้งแล้ง 

  

ข้อมลูฝนจากสถานี 

NVSWI 

  

VHI  NPA  

ดชันีท่ีเหมาะสมกบัพืน้ท่ีศกึษา 

LST 
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บทที่ 2 

เอกสารและงานวิจัยที่เกี่ยวข้อง 

 การศึกษาเร่ือง การประเมินความถูกต้องดชันีภัยแล้งด้วยข้อมูลผลิตภัณฑ์ดาวเทียมใน

พืน้ท่ีศึกษาลุ่มแม่น า้น่านผู้ วิจยัได้ท าการรวบรวมหลกัการ แนวคิด ทฤษฎี เอกสารและงานวิจยัท่ี

เก่ียวข้อง โดยมีรายละเอียดของประเดน็ตา่งๆ ดงันี ้

2.1 ลกัษณะทางกายภาพของลุม่น า้นา่น 

2.2 สภาพอตุนุิยมวิทยาและอทุกวิทยา 

2.3 ภยัแล้งในประเทศไทย 

2.4 ดาวเทียม TRMM (Tropical Rainfall Measuring Mission) 

2.5 เคร่ืองมือ MODIS 

2.6 เอกสารและงานวิจยัท่ีเก่ียวข้อง 

 

2.1 ลักษณะทางกายภาพของลุ่มน า้น่าน  
2.1.1 ลักษณะภูมิประเทศ 

โดยแมน่ า้นา่น มีต้นก าเนิดจากเทือกเขาหลวงพระบาง   ซึง่เป็นเส้นแบง่เขตแดนไทย - ลาว  

ไหลผ่านท่ีราบระหว่างหบุเขาในเขตอ าเภอเมือง และอ าเภอเวียงสา จงัหวดัน่าน  แล้วไหลลงสู่อ่าง

เก็บน า้สิริกิติ์  พืน้ท่ีตอนล่างของลุ่มน า้น่านเป็นท่ีราบสองฝ่ังแม่น า้  จากจงัหวดัพิษณุโลก  แม่น า้

น่านจะไหลคู่กับแม่น า้ยมลงมาบรรจบกันท่ีอ าเภอชุมแสง  จังหวัดนครสวรรค์  และไหลผ่านบึง

บอระเพ็ดทางฝ่ังซ้าย  ก่อนจะไหลลงแม่น า้ปิงท่ีอ าเภอเมือง  จงัหวดันครสวรรค์ ซึ่งเป็นจุดเร่ิมต้น

ของแม่น า้เจ้าพระยา ส าหรับพืน้ท่ีครอบคลมุของลุ่มน า้นา่นในเขตจงัหวดัตา่งๆ แสดงดงัตาราง 2.1 

โดยบอกขนาดของพืน้ท่ีโดยรวมและพืน้ท่ีท่ีอยู่ในลุ่มน า้ (สถาบันสารสนเทศทรัพยากรน า้และ

การเกษตร,2555) 
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ตาราง 2.1 รายละเอียดจังหวัดของลุ่มน า้น่าน 

จังหวัด พืน้ท่ีจังหวัด  (ตร.กม.) พืน้ท่ีในเขตลุ่มน า้น่าน 

(ตร.กม.) (ไร่) 

น่าน 12,215.06 11,632.90 7,270,562 

อุตรดติถ์ 7,855.21 7,759.30 4,849,565 

พจิิตร 4,341.96 2,530.58 1,581,614 

พษิณุโลก 10,524.94 8,983.52 5,614,700 

นครสวรรค์ 9,567.04 748.04 467,526 

รวม  31,654.34 19,783,967 

ท่ีมา: เอกสารการด าเนินการด้านการรวบรวมข้อมูลและวิเคราะห์ข้อมูลโครงการพัฒนาระบบ

คลงัข้อมลู 25 ลุม่น า้และแบบจ าลองน า้ทว่มน า้แล้งสถาบนัสารสนเทศทรัพยากรน า้และการเกษตร 

 

2.2 สภาพอุตุนิยมวิทยาและอุทกวิทยา 
 2.2.1 สภาพภูมิอากาศ 

พืน้ท่ีลุ่มน า้น่านนัน้อยู่ภายใต้อิทธิพลของลมมรสุมตะวันตกเฉียงใต้และลมมรสุม
ตะวนัออกเฉียงเหนือ  และมีพายดีุเปรสชัน่และพายไุต้ฝุ่ น ซึ่งมาจากทะเลจีนใต้พดัผ่านเข้ามาเป็น
ครัง้คราว ซึ่งส่งท าให้เกิดฤดกูาลต่างๆ ได้แก่ฤดูฝนจะเกิดในช่วงเดือนพฤษภาคมถึงเดือนตลุาคม 
ฤดูหนาวจะเกิดในช่วงปลายเดือนตุลาคมถึงเดือนกุมภาพันธ์ และฤดูร้อนจะเกิดในช่วงเดือน
มีนาคมถึงเดือนเมษายน จากการรวบรวมข้อมลูภูมิอากาศท่ีสถานีตรวจอากาศต่างๆ ในเขตพืน้ท่ี
ลุ่มน า้น่าน ซึ่งบนัทึกไว้โดยกรมชลประทาน จ านวน 7 สถานี ได้แก่ สถานีจงัหวดัน่าน สถานีสกษ.
นา่น สถานีท่าวงัผา สถานีทุ่งช้าง สถานีจงัหวดัอตุรดิตถ์สถานี จงัหวดัพิษณุโลก และสถานีจงัหวดั
นครสวรรค์ แสดงข้อมูลภูมิอากาศท่ีส าคญัในลุ่มน า้น่านโดยมีค่าตวัแปรภูมิอากาศทัง้ห้าตวัได้แก่ 
อณุหภูมิ ซึ่งอณุหภูมิสงูสดุรายปีในพืน้ท่ีลุม่น่านคือ28 องศาเซลเซียส อณุหภูมิต ่าสดุรายปีอยู่ท่ี 25 
องศาเซลเซียส และมีอณุหภมูิเฉล่ียรายปีท่ี 26 องศาเซลเซียส ความชืน้สมัพทัธ์ท่ีมีคา่เฉล่ียรายปีอยู่
ท่ีร้อยละ 74 ความเร็วลม เมฆปกคลุม การระเหย ซึ่งปัจจัยทัง้หลายเหล่านีเ้ป็นตวัแปรส าคญัท่ี
สามารถใช้ส าหรับการสร้างดชันีภัยแล้ง ดงัตาราง 2.2 ท่ีสรุปค่าสูงสุด ต ่าสุดและค่าเฉล่ียของตวั
แปรภมูิอากาศท่ีเป็นปัจจยัให้เกิดความแห้งแล้ง 
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ตาราง 2.2 ข้อมูลภูมิอากาศท่ีส าคัญ 

ข้อมลูภมูิอากาศท่ีส าคญั หนว่ย คา่สงูสดุรายปี คา่ต ่าสดุรายปี คา่เฉล่ียรายปี 

อณุหภมูิ องศาเซลเซียส 28.2 25.2 26.8 

ความชืน้สมัพทัธ์ เปอร์เซ็นต์ 79.8 70.4 74.5 
ความเร็วลม น๊อต 3.0 0.6 1.3 

เมฆปกคลมุ 0-10 5.6 5.1 5.4 

ปริมาณการระเหย มิลลิเมตร 2,018.0 1,244.5 1,596.3 

ท่ีมา: เอกสารจากสว่นอ านวยการและประเมินผล กรมชลประทาน 
 

2.2.2 ปริมาณฝน 
รวบรวมข้อมูลปริมาณฝนรายเดือนของสถานีวดัน า้ฝนท่ีรวบรวมโดยการไฟฟ้าฝ่ายผลิต

แห่งประเทศไทย จ านวน 84 สถานีพบว่า มีเพียง 36 สถานีท่ีมีช่วงเวลาของการจดบนัทึกข้อมลูค่า
ปริมาณฝนรายเดือนเฉล่ียของแตล่ะสถานีครบตลอดทัง้ปี และเลือกมา7สถานีท่ีอยู่ในพืน้ท่ีลุ่มน า้
น่าน มีปริมาณฝนเฉล่ีย 1,041 มิลลิเมตร/ปี จากการวิเคราะห์ภาพ 2.1 พบว่า การกระจายตวัของ
ปริมาณฝนจะเกิดตัง้แต่เดือนพฤษภาคมไปจนถึงเดือนตุลาคม โดยมีปริมาณฝนสูงสุดในเดือน
กนัยายนและปริมาณฝนน้อยสดุในเดือนกมุภาพนัธ์ 

  

 
ภาพ 2.1 ปริมาณน า้ฝนเฉล่ียรายปีในพืน้ท่ีลุ่มน า้น่าน 
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2.3 ภัยแล้งในประเทศไทย 
 ภยัแล้ง คือ ภยัท่ีเกิดจากการขาดแคลนน า้ในพืน้ท่ีใดพืน้ท่ีหนึ่งเป็นเวลานาน จนก่อให้เกิด
ความแห้งแล้ง ส าหรับภัยแล้งในประเทศไทย ส่วนใหญ่เกิดจากฝนแล้งและทิง้ช่วง ซึ่งฝนแล้งเป็น
ภาวะปริมาณฝนตกน้อยกวา่ปกตหิรือฝนไมต่กต้องตามฤดกูาล จากข้อมลูจากอตุนุิยมวิทยา ฝนทิง้
ชว่งหมายถึง ช่วงท่ีมีปริมาณฝนตกไม่ถึงวนัละ 1 มิลลิเมตรติดตอ่กนัเกิน 15 วนั ในชว่งฤดฝูน เดือน
ท่ีมีโอกาสเกิดฝนทิง้ช่วงสงูคือ เดือนมิถนุายนและกรกฎาคม ภยัแล้งสามารถแบง่ได้เป็น 4 ประเภท
คือ 

1) ความภยัแล้งทางอตุนุิยม เกิดจากสภาพฝนทิง้ชว่งหรือฝนตกน้อยกวา่ระดบัท่ีก าหนด  
2) ความภัยแล้งทางเกษตรกรรม ท่ีเกิดจาการท่ีน า้ในดินมีน้อยขาดความชุ่มชืน้ส่งผลต่อ

การเจริญเตบิโตของพืช  

3) ความภยัแล้งทางอทุกวิทยา ท่ีสงัเกตจากระดบัน า้ใต้ดินและระดบับนผิวดนิ ระดบัน า้ใน
แมน่ า้ล าคลอง  

4) ความภัยแล้งทางเศรษฐศาสตร์และสงัคม สภาวะการขาดแคลนน า้ซึ่งมีผลกระทบต่อ
สภาพเศรษฐกิจในภมูิภาค 

ความรุนแรงจะเพิ่มขึน้หรือลดลงขึน้อยู่กับปัจจัยหลายด้าน เช่น ความชืน้ในอากาศ 
ความชืน้ในดนิ  ระยะเวลาท่ีเกิดความแห้งแล้งและขนาดของพืน้ท่ีท่ีมีความแห้งแล้ง เป็นต้น  
โดยภยัแล้งในประเทศไทยจะเกิดใน 2 ชว่ง ได้แก่ 

1) ช่วงฤดหูนาวตอ่เน่ืองถึงฤดรู้อน ซึ่งเร่ิมจากคร่ึงหลงัของเดือนตลุาคมเป็นต้นไป บริเวณ
ประเทศไทยตอนบน (ภาคเหนือ ภาคตะวันออกเฉียงเหนือ ภาคกลางและภาคตะวันออก) จะมี
ปริมาณฝนลดลง จนกระทัง่เข้าสู่ฤดฝูนในชว่งกลางเดือนพฤษภาคมของปีถดัไปซึ่งภยัแล้งลกัษณะ
นีจ้ะเกิดขึน้เป็นประจ าทกุปี 

2) ชว่งกลางฤดฝูน ประมาณปลายเดือนมิถนุายนถึงเดือนกรกฎาคม จะมีฝนทิง้ชว่งเกิดขึน้ 
ภยัแล้งลกัษณะนีจ้ะเกิดขึน้เฉพาะท้องถ่ินหรือบางบริเวณ บางครัง้อาจครอบคลมุพืน้ท่ีเป็นบริเวณ
กว้างเกือบทัว่ประเทศ (สวีณา, 2547) 
 
2.4 ดาวเทียม TRMM (Tropical Rainfall Measuring Mission) 

Tropical Rainfall Measuring Mission (TRMM) เป็นการร่วมภารกิจอวกาศระหว่างนาซา
และส ารวจอวกาศญ่ีปุ่ น Agency (JAXA) ท่ีออกแบบมาเพ่ือตรวจสอบและศกึษาปริมาณน า้ฝนเขต
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ร้อน โดยดาวเทียมเปิดตวัวนัท่ี 27 พฤศจิกายน 1997 ข้อมลูนาซ่าจากTRMM เป็นดาวเทียมท่ีมีวง
โคจรไม่สัมพันธ์กับดวงอาทิตย์ ท่ีระดับความสูง 403 กิโลเมตร ระนาบวงโคจรเอียง (Inclined 
Orbit) ท ามุม 35 องศากับเส้นศนูย์สูตรดงัภาพ 2.2 ใช้เวลา 92.5 นาทีส าหรับการโคจรรอบโลก 1 
รอบ  โคจรทั ง้ หมด 16 รอบในหนึ่ ง วัน  (National Aeronautics and Space Administration 
ดาวเทียม TRMM ได้ติดตัง้ทัง้อุปกรณ์แบบ Passive Microwave และแบบ Active Microwave 
ทัง้นีอ้ปุกรณ์ท่ีของ TRMM มีอยู ่5 ชนิดคือ 

1) เคร่ือง PR (Precipitation Radar) เรดาร์ฝน ท างานท่ีช่วงคล่ืน 13.81 GHz มีความ
ละเอียด 4.3 กิโลเมตรท่ีรัศมี 220 กม. การวดันีใ้ห้ข้อมลูเก่ียวกบัความเข้มและการกระจายของฝน
ในประเภทฝนท่ีระดบัความลึกของพายุและความสูงท่ีหิมะละลายเป็นฝน การประมาณค่าความ
ร้อนท่ีปลอ่ยออกสูช่ัน้บรรยากาศท่ีระดบัความสงูตา่งกนั  

2) เคร่ือง VIRS (Visible/Infrared Scanner) เคร่ืองสแกนเนอร์อินฟราเรดท างานท่ีช่วงคล่ืน 
0.60 - 12 ไมโครเมตร ความละเอียด 2.0 กิโลเมตร ท าหน้าท่ีเป็นตวับง่ชีป้ริมาณน า้ฝนโดยอ้อม 

3) เคร่ือง TMI (TRMM Microwave Image) เคร่ืองตรวจจับคล่ืนไมโครเวฟ มี 5 Band 
ท างานท่ีช่วงคล่ืน 10 - 90 GHz ความละเอียด 5 - 45 กิโลเมตร สามารถท่ีจะวัดปริมาณไอน า้ใน
เมฆและความเข้มของปริมาณน า้ฝนในบรรยากาศ  

4) เค ร่ือง  CERLS (Clouds and the Earths Radiant Energy System) เซน เซอ ร์วัด
พลงังานของเมฆและความร้อนของโลก ท างานท่ีช่วงคล่ืน 0.3 - 50 ไมโครเมตร ความละเอียด 25 
กิโลเมตร วดัพลงังานท่ีชัน้บรรยากาศรวมถึงการประเมินระดบัพลงังานภายในชัน้บรรยากาศและท่ี
ผิวโลก การใช้ข้อมูลจากเคร่ืองมือถ่ายภาพเมฆท่ีมีความละเอียดสูง เพ่ือท าความเข้าใจระบบ
ภมูิอากาศโดยรวมของโลก 

5) เคร่ือง LIS (Lightning Imaging Sensor) ท างานท่ีช่วงคล่ืน 0.774 ไมโครเมตร ความ
ละเอียด 4 กิโลเมตร เป็นเคร่ืองมือขนาดเล็กท่ีมีความซับซ้อนสูงซึ่งสามารถตรวจจับและหาค่า
สายฟ้าได้ และตรวจจบัฟ้าผา่ภายในพายแุตล่ะตวัได้ 
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ภาพ 2.2 ข้อมูลของดาวเทียม TRMM (ที่มา: National Aeronautics and Space 

Administration  อ้างอิงใน ศรินทร์ทพิย์ แทนธานี, 2557) 
 
2.5 เคร่ืองมือ MODIS 

เคร่ืองมือ MODIS ท างานได้ทัง้บนยานอวกาศ Terra และ Aqua มีความกว้างประมาณ 
2,330 กม. และมองเห็นพืน้ผิวทัง้หมดของโลกทกุ 1-2 วนั เคร่ืองตรวจจบัมีขนาด 36 แถบสเปกตรัม
ระหวา่ง 0.405 และ 14.385 μm และจะได้ข้อมลูท่ีความละเอียดเชิงพืน้ท่ีสามขนาด 250 เมตร 500 
ม. และ 1,000 ม.พร้อมกับข้อมูลทัง้หมดจากเคร่ืองมืออ่ืน ๆ บนยานอวกาศ Terra และ Aqua 
Spacecraft ข้อมูล MODIS จะถูกโอนไปยงัสถานีภาคพืน้ดินใน White Sands รัฐนิวเม็กซิโกผ่าน
ระบบติดตามและข้อมูลดาวเทียมรีเลย์ (TDRSS) ซึ่งมีประโยชน์ในการติดตามสถานการณ์ต่างๆ 
ในระดบัภูมิภาคได้ทุกวัน เน่ืองจากภาพถ่ายจากดาวเทียมระบบ MODIS มีแถบการถ่ายภาพท่ี
กว้างครอบคลมุทัว่ประเทศไทยได้ในการถ่ายเพียงครัง้เดียว รวมทัง้มีจ านวนแบนด์ถ่ายภาพจ านวน
มากท าให้สามารถวิเคราะห์ได้หลายรูปแบบ ผลิตภัณฑ์ท่ีได้จากการสงัเกตการณ์ของ MODIS จะ
อธิบายคณุลกัษณะของแผ่นดินมหาสมทุรและบรรยากาศท่ีสามารถใช้ส าหรับการศึกษาเก่ียวกับ
กระบวนการและแนวโน้มในระดบัท้องถ่ินและระดบัโลก  
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ภาพ 2.3 ดาวเทียม MODIS (ที่มา: https://modis.gsfc.nasa.gov/) 

 
2.6 เอกสารและงานวิจัยท่ีเก่ียวข้อง 

เทวินทร์ โจมทา (2549) ได้ศกึษาแบบจ าลองดชันีความแห้งแล้งทางอตุนุิยมวิทยา ในพืน้ท่ี
ประสบภัยแล้งบริเวณภาคตะวนัออกเฉียงเหนือ เป็นการวิเคราะห์วิจยัแบบจ าลองดชันีชีว้ดัความ
แห้งแล้งทางอตุนุิยมวิทยา Palmer Drought Severity Index (PDSI), Standardized Precipitation 
Index (SPI), Aridity Anomaly Index (AI) และ The Meteorological Drought Index (D) ในคาบ 
10 ปี ตัง้แต ่พ.ศ. 2536 – 2545 ผลการศกึษาพบว่า จากผลการวิเคราะห์ทางสถิติพบว่าในปี 2536 
และ 2541 เป็นปีท่ีมีความแห้งแล้งรุนแรงท่ีสุดเป็นอันดบัท่ีหนึ่งและสองตามล าดบั และจากการ
วิเคราะห์เปรียบเทียบหาความสมัพนัธ์กนัทางสถิติ ส าหรับในปี 2536 ได้คา่สมัประสิทธ์ิสหสมัพนัธ์
แบบเมทริกซ์ (Matrix Correlations Coefficient) ท่ีระดบันยัส าคญั 0.01 ซึ่งมีความสมัพนัธ์กนัมาก
ท่ีสุดระหว่างค่าดชันี PDSI กับ AI เท่ากับ 0.657 ส าหรับค่าดชันี SPI นัน้มีความสมัพนัธ์กันกับค่า
ดัชนีชนิดอ่ืนๆ ค่อนข้างน้อย ยกเว้นเฉพาะในกลุ่มของ SPI ด้วยกันเท่านัน้ท่ีมีค่าสัมประสิทธ์ิ
สหสมัพนัธ์สูงท่ีสดุคือระหว่างคา่ดชันี SPI9 กับ SPI12 มีค่าเท่ากบั 0.983 ส่วนในปี 2541 ระหว่าง
ค่าดชันี PDSI กับ D มีความสัมพนัธ์กันมากท่ีสุดซึ่งมีค่าเท่ากับ 0.516 และจากการเปรียบเทียบ
โดยการซ้อนทับข้อมูลกันด้วยวิธีคะแนนถ่วงน า้หนัก (Weighting Score Method) พบว่าแผนท่ี
แสดงความแห้งแล้งตามคา่ดชันี AI ให้คา่ใกล้เคียงกบัแผนท่ีแสดงพืน้ท่ีเส่ียงภยัแล้งมากท่ีสดุ  

รฐนนท์ จนัทร์อินทร์ และคณะ (2560) ได้ศกึษาดชันีความแตกตา่งพืชพรรณแบบนอร์มอล
ไลซ์หลายชว่งเวลาจากข้อมลู MODIS ส าหรับตดิตามปัญหาภยัแล้งในพืน้ท่ีฝ่ังตะวนัออกของแมน่ า้
ปิง จงัหวดัก าแพงเพชร โดยการน า NDVI จากข้อมลู MODIS ในช่วงเวลา ปี พ.ศ. 2556-2559 พืน้ท่ี
ฝ่ังตะวันออกของแม่น า้ปิง จังหวดัก าแพงเพชร ซึ่งเป็นพืน้ท่ีเกษตรกรรมขนาดใหญ่และมีปัญหา
ด้านภยัแล้ง มีขัน้ตอนโดยการรวบรวมข้อมลู NDVI ผสม 16 วนั จากอลักอริทมึ MOD13A1 จากนัน้
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แปลงเป็นข้อมูลรายเดือน เพ่ือวิเคราะห์เปรียบเทียบการเปล่ียนแปลงตามช่วงเวลาของข้อมูล
ดงักล่าว ผลการศึกษา พบว่า ในพืน้ท่ีเกษตรกรรม มีค่าเฉล่ีย NDVI ปี พ.ศ. 2556-2559 เท่ากับ 
0.57 0.59 0.56 และ 0.54 ตามล าดบั และมีคา่เฉล่ีย 4 ปีเทา่กบั 0.56 เดือนสิงหาคม กนัยายน และ
พฤศจิกายน เป็นช่วงท่ีมีค่า NDVI สูง (0.70 0.69 และ 0.67) ส่วนเดือนเมษายน มีนาคม และ
กุมภาพันธ์ เป็นช่วงท่ีมีค่า NDVI ต ่า (0.43 0.44 และ 0.46) เม่ือเปรียบเทียบ 4 ปี พบว่า ปี พ.ศ. 
2559 เป็นปีท่ีมีภาพรวมคา่ NDVI ต ่ากว่าปีอ่ืนๆ แผนท่ีการกระจายตัวของคา่ NDVI สามารถแสดง
ความแห้งแล้งเชิงเกษตรกรรมเบือ้งต้นได้  

สบุรร ผลกะสิ (2559) ได้ศกึษาความสมัพนัธ์ระหว่างปริมาณฝนดาวเทียมกบัฝนสถานีใน
พืน้ท่ีลุ่มน า้น่าน โดยดคูวามสมัพนัธ์ระหว่างปริมาณฝนจากการส ารวจโดยดาวเทียม TRMM และ
ปริมาณฝนจากสถานีวดัฝนของกรมอตุนุิยมวิทยาในพืน้ท่ีลุ่มน า้น่าน โดยใช้ข้อมลูฝนราย 3 ชัว่โมง
ระหว่างปี 2552 ถึง 2554 ผลการศึกษาพบว่าปริมาณฝนจากดาวเทียมมีปริมาณมากกว่าฝนจาก
สถานีวัดปริมาณฝนจากดาวเทียมส่วนใหญ่ร้อยละ 48 มีค่าอยู่ระหว่าง 0 - 5 มิลลิเมตร ค่า
เปอ ร์ เซ็ น ต์การตรวจจับสัญญาณ ( Probability Of Detection ,POD) มีค่า  58 % การหา
ความสัมพันธ์เชิงเส้นตรงโดยใช้ข้อมูลฝนรายเดือนได้ค่าสัมประสิทธ์ิการตดัสินใจ (R2) เท่ากับ 
0.557 

อภิษฐา ยอดยิ่ง (2559) ได้ศึกษาเก่ียวกับการเปรียบเทียบปริมาณน า้ฝนรายวันระหว่าง
ผลิตภัณฑ์น า้ฝนจากข้อมูลดาวเทียมกับข้อมูลน า้ฝนภาคพืน้ดิน พืน้ท่ีภาคเหนือของประเทศไทย 
เน้นวิเคราะห์การเปรียบเทียบปริมาณน า้ฝนรายวนัระหว่างผลิตภัณฑ์น า้ฝนจากข้อมูลดาวเทียม 
TRMM กับข้อมูลน า้ฝนภาคพืน้ดินจานวน 78 สถานีของกรมอุตุนิยมวิทยา พืน้ท่ีภาคเหนือของ
ประเทศไทย ในปี พ.ศ. 2553 และ 2554 โดยใช้วิธีการทางสถิติ ได้แก่ Bias, Root Mean Square 
Difference (RMSD), Mean Absolute Deviation (MAD), Probability of Detection (POD), False 
Alarm Rate (FAR) และ Critical Success Index (CSI) ผลการศึกษาพบว่า ปริมาณน า้ฝนท่ี
ตรวจวัดด้วยดาวเทียมมีค่ามากกว่าฝนภาคพืน้ดินเป็นส่วนใหญ่ ซึ่งจะต่างกันตามปริมาณและ
ความแรงของน า้ฝนท่ีเกิดขึน้ในแต่ละปี ในปีท่ีมีปริมาณน า้ฝนมาก น า้ฝนท่ีตรวจวดัด้วยดาวเทียม
จะมีคา่มากกว่าฝนภาคพืน้ดิน นอกจากนีพ้บวา่ดาวเทียม TRMM 3B42 V.7 ยงัมีความบกพร่องใน
การตรวจวดัปริมาณน า้ฝนขณะท่ีฝนตกหนกัในชว่งฤดฝูน 

Aulia et al. (2015) ได้ศึกษาเก่ียวกับการตรวจสอบความแห้งแล้งในนาข้าวของเกาะชวา
ตะวนัตกโดยใช้ภาพดาวเทียม MODIS EVI ปรากฏการณ์แห้งแล้งเกิดขึน้ในหลายพืน้ท่ีในประเทศ
อินโดนีเซียถูกกล่าวว่าเกิดจากปรากฏการณ์ El Nino ท าให้เกิดความเสียหายในการเพาะปลกู ใน
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จงัหวดัชวาฝ่ังตะวนัตกเป็นหนึง่ในศนูย์กลางของทางการเกษตรในอินโดนีเซีย ประสบภยัแล้งรุนแรง
ภายในระยะเวลา 6 เดือน(เมษายน - กันยายน 2546) การตรวจสอบความแห้งแล้งเป็นประโยชน์
ตอ่การท าความเข้าใจลกัษณะของภยัแล้ง เพ่ือหาทางลดผลกระทบของปรากฏการณ์นี  ้การศกึษา
ครัง้นีใ้ช้ข้อมูลจากระยะไกลเพ่ือศึกษาการตอบสนองของพืชบนปรากฏการณ์ภัยแล้ง ชุดเวลา 
MODIS EVI ถูกใช้ดูแนวโน้มตามฤดูกาลและส่วนท่ีเหลือโดยใช้ BFAST Breaks for Additive 
Season and Trend (BFAST) อัลกอริธึมส าหรับการตรวจจับและตรวจสอบพืน้ท่ีนาท่ีประสบ
ปัญหาภยัแล้งในชวาตะวนัตกซึ่งช่วยให้สามารถตรวจจบัการเปล่ียนแปลงของแนวโน้มภายในชุด
ข้อมลูได้ ผลการศกึษาพบวา่ BFAST สามารถตรวจจบัความแห้งแล้งได้ในชดุเวลา MODIS EVI ผล
ท่ีได้เม่ือเทียบกบัดชันีความแห้งแล้งใหมท่ี่เรียกว่า SPEI 

Cong et al. (2016) ได้ศึกษาเก่ียวกับลกัษณะภัยแล้งในช่วงปี พ.ศ. 2544-2557 ด้วยการ
รับรู้ระยะไกล ศกึษาบริเวณภาคตะวนัออกเฉียงเหนือของประเทศจีน โดยใช้ดชันีความแห้งแล้งสาม
รูปแบบไ ด้แก่  Normalized Monthly Precipitation Anomaly Percentage (NPA), Vegetation 
Health Index (VHI) and Normalized Vegetation Supply Water Index (NVSWI) และใช้ ข้อมูล
ดาวเทียมความชืน้ดินตรวจสอบจากการหาความสัมพนัธ์ระหว่างข้อมูลความชืน้ดินและดชันีภัย
แล้งทัง้สามและประเมินความแห้งแล้งในบริเวณภาคตะวันออกเฉียงเหนือของประเทศจีนและ
ตรวจสอบความล่าช้าของฝนจากการน าข้อมลูTRMM3B42มาตรวจสอบกบัข้อมลูฝนจากสถานี ผล
การศกึษาแสดงให้เห็นว่าสมัประสิทธ์ิสหสมัพนัธ์ของ NVSWI มีคา่ความชืน้สมัพทัธ์ของดิน AMSR-
E มีคา่เท่ากบั 0.68 พฤษภาคม 0.56 ในเดือนกรกฎาคมและ 0.53 ในเดือนกนัยายนแสดงให้เห็นถึง
การบังคับใช้ ท่ีดี ท่ีสุดในการติดตามความแห้งแล้งในภาคตะวันออกเฉียงเหนือของจีนมี
ความสมัพนัธ์กบัความชืน้ในดินสงูท่ีสดุ โดยมีความสมัพนัธ์ระหว่างฝนและภยัแล้ง พืน้ท่ีส่วนใหญ่
ในภาคตะวนัออกเฉียงเหนือของจีนถกูโจมตีโดยภยัแล้งในช่วงฤดหูนาว ในฤดแูล้งการกระจายตวั
ของความแห้งแล้งในฤดแูล้งพบว่าความแห้งแล้งเกิดขึน้ได้ง่ายกวา่ในภาคตะวนัออกเฉียงเหนือของ
ภาคตะวนัออกเฉียงเหนือของประเทศจีน 

Wang et al. (2014) ได้ศึกษาเก่ียวกบั ผลกระทบของความแห้งแล้งตอ่ระบบนิเวศของพืช
ในภาคตะวนัตกเฉียงใต้ของจีนโดยอาศยัการส ารวจระยะไกล เน่ืองจากตะวนัตกเฉียงใต้ของจีน
ได้รับความเดือดร้อนจากภาวะแห้งแล้งท่ีไมค่อ่ยได้เกิดขึน้ในฤดกูาลเดียวกนัของปีท่ีผ่านมาคกุคาม
ระบบนิเวศพืชอย่างมาก จึงได้มีการน าความแตกตา่งในแตล่ะปีของ NDVI มาใช้ในการประเมินผล
กระทบของความแห้งแล้งต่อระบบนิเวศของพืช ผลการศึกษาพบว่า ตัง้แต่เดือนสิงหาคม 2552 
จนถึงเดือนมีนาคม 2553: 
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1) พืชในภาคตะวนัตกเฉียงใต้ของประเทศจีนได้รับผลกระทบอย่างนา่มากโดยความแห้ง
แล้งมีแนวโน้มท่ีเพิ่มสงูขึน้ 

2) พืน้ท่ีของระบบนิเวศพืชท่ีได้รับความเดือดร้อนจากภัยพิบตัิครัง้นีใ้นมณฑลยูนนาน 
มณฑลกวางสีและกุ้ ยโจวมีมากขึน้มากกว่า 80% ของพืน้ท่ีทัง้หมด จากระบบนิเวศ
ของพืชในสามเขตปกครอง 

3) พืน้ท่ีเพาะปลกูพืชเสียหายจึงส่งผลให้พืชท่ีปลกูไว้ตายและมีการลดลงของน า้ในแหล่ง
น า้ 

ผลการศกึษาสอดคล้องกบัผลจากการตรวจสอบแสดงให้เห็นวา่ความแตกตา่งในแตล่ะปีของ NDVI 
ตอบสนองอยา่งมากตอ่พืน้ท่ีและเวลาความแห้งแล้งซึง่อาจเป็นตวับง่ชีถ้ึงการเกิดและความคืบหน้า
ของความแห้งแล้งและการกระจายของความแห้งแล้ง 
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บทที่ 3 
วิธีด าเนินการวิจัย 

 งานวิจัยนีเ้ป็นการศึกษาการประเมินความถูกต้องดัชนีภัยแล้งด้วยข้อมูลผลิตภัณฑ์

ดาวเทียมในพืน้ท่ีศึกษาลุ่มแม่น า้น่านโดยในการศึกษานีเ้ลือกสามดชันีคือ Normalized Monthly 

Precipitation Anomaly Percentage (NPA), Vegetation Health Index (VHI) และ  Normalized 

Vegetation Supply Water Index (NVSWI) และใช้ข้อมลู TRMM3B42 เข้ามาชว่ยในการตรวจสอบ 

เพ่ือศึกษาความแตกต่างของดชันีภัยแล้งทัง้สามตวัและต้องการหาดชันีภัยแล้งท่ีเหมาะสมพืน้ท่ี

ศกึษาลุม่น า้นา่นโดยแบง่วิธีการด าเนินวิจยัเป็น 4 สว่น ดงันี ้

3.1 เคร่ืองมือท่ีใช้ในการวิจยั 

3.2 ข้อมลูและแหลง่ข้อมลู 

3.3 การเก็บรวบรวมข้อมลู 

3.4 การวิเคราะห์ข้อมลู 

3.1 เคร่ืองมือที่ใช้ในการวิจัย 

1) คอมพิวเตอร์สว่นบคุคล Intel(R) Core(TM) i5-6200U CPU @ 2.30GHz RAM 8 GB 

2) โปรแกรมทางสารสนเทศภมูิศาสตร์ 

3) โปรแกรม Microsoft Excel 2013 

 

 

 

 

 

 

 

 

 

 

 

 



 
18 

 

  

3.2 ข้อมูลและแหล่งข้อมูล 
 ตาราง 3.1 แสดงข้อมูลและแหล่งข้อมูลท่ีใช้ 

 
3.3 การเก็บรวบรวมข้อมูล 

ผู้ วิจัยได้ท าการเก็บข้อมูลรวบรวมข้อมูลท่ีใช้ในการศึกษาได้แก่  ข้อมูลจากผลิตภัณฑ์

ดาวเทียม MODIS สองผลิตภัณฑ์ คือ  NDVI (MOD13C2) และ LST (MOD11C3) ข้อมลูปริมาณ

น า้ฝนจากสถานี ผลิตภณัฑ์TRMM3B42 และข้อมลูพืน้ท่ีชลประทาน 

 

 

 

 

ล าดบั ข้อมลู หนว่ยงาน/แหลง่ข้อมลู ปี พ.ศ. ลกัษณะข้อมลู 
1  ผลิตภณัฑ์ 

MODIS 
NDVI   

https://search.earthdata.nasa.
gov/search 

2551-2560 เป็นข้อมลูราสเตอร์ 
ความละเอียดเชิง
พืน้ท่ี 0.05 ° 

2 ผลิตภณัฑ์ 
MODIS LST 

https://search.earthdata.nasa.
gov/search 

2551-2560 เป็นข้อมลูราสเตอร์ 
ความละเอียดเชิง
พืน้ท่ี 0.05 ° 

3 ข้อมลู
ปริมาณ
น า้ฝนจาก
สถานี 

ศนูย์อทุกวิทยาชลประทาน 2551-2560 เป็นข้อมลูจงัหวดั 
ช่ือสถานี รหสั

สถานี และปริมาณ
น า้ฝน 

4 ผลิตภณัฑ์ 
TRMM3B42  

https://mirador.gsfc.nasa.gov/ 2551-2560 ความละเอียด
ขนาด 

0.25°x0.25° และ
ปริมาณฝนรายวนั 

5 ข้อมลูพืน้ท่ี
ชลประทาน 

https://www.esri.com/th-
th/arcgis/products/arcgis-

online/overview 

2551-2560 เป็นข้อมลูท่ีแสดง
พืน้ท่ีชลประทาน
ทัง้ประเทศ 
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3.3.1 ผลิตภัณฑ์ MODIS NDVI และ LST 

1) ดาวน์โหลดผลิตภัณฑ์ NDVI และ LST (MOD13C2 และ MOD11C3 ตามล าดับ) 

ในช่วงปี พ.ศ. 2551-2560 ทัง้สองผลิตภัณฑ์อยู่ในช่วงเวลา 30 วันและมีความละเอียดเชิงพืน้ท่ี 

0.05 ° ซึ่งได้มาจากเว็บไซต์ท่ีให้บริการโดย Earth data ของ National Aeronautics and Space 

Administration (NASA) โดยไปท่ี https://search.earthdata.nasa.gov/search  

2) พิมพ์ในช่องค้นหาเลือกผลิตภัณฑ์ท่ีต้องการโดยผู้ วิจัยต้องดาวน์โหลดผลิตภัณฑ์ 

MOD13C2 และ MOD11C3 โดยท าการก าหนดเขตพืน้ท่ีเป็นลุ่มน า้น่าน และเวลาท่ีต้องการคือปี 

พ.ศ.2551-2560  

3) น าข้อมูลผลิตภัณฑ์ทัง้สองมาเข้าโปรแกรมทางภูมิศาสตร์ เพ่ือท าการตดัเฉพาะพืน้ท่ี

ศกึษาและแปลงระบบพิกดัจาก GCS_Clarke_1866 เป็น GCS_WGS_1984 

4) ท าการแปลงระบบพิกดัก่อนน าไปตดัพืน้ท่ีศกึษาโดยไปท่ีเคร่ืองมือ Data Management 

tools > Projection and Transformation > Raster > Project Raster ดงัภาพ 3.1 

5) การตัดเฉพาะพืน้ท่ีศึกษาท าได้โดยการไปท่ีเคร่ืองมือ Data management tools > 

Raster > Raster Processing > Clip ดงัภาพ 3.2  

6) ท าการตรวจสอบคุณภาพของข้อมูล NDVI ตามสมการ 3.1 เพ่ือกรองข้อมูลโดยใช้

เคร่ืองมือ Spatial Analyst Tools > Extraction > Map Algebra > Raster Calculator ดงัภาพ 3.3 

                                          ((QC==0) & (NDVI>2000))*NDVI                             (สมการท่ี 3.1) 

จากข้อมลูลกัษณะชัน้ข้อมลูในตารางผลิตภณัฑ์ MODIS ซึง่จะบอกประเภทของข้อมลูและ

ช่วงค่าท่ีถูกต้องของข้อมูลผลิตภัณฑ์ โดย QC คือความน่าเช่ือถือของข้อมูลและเน่ืองจากค่าท่ีได้

ไมใ่ชค่า่ NDVI ท่ีแท้จริงจงึต้องน ามาคณูด้วย 0.0001 จงึได้คา่ NDVI 

7) ท าการตรวจสอบคณุภาพของข้อมลู LST จากสมการ 3.2 โดยใช้เคร่ืองมือ Spatial 

Analyst Tools > Extraction > Map Algebra > Raster Calculator  

                                           [((LST > 7500)*7500)*0.02]-273.15                        (สมการท่ี 3.2) 

จากช่วงท่ีถกูต้องของข้อมลูคือ 7500 และ 0.02 คือสเกลแฟกเตอร์ของข้อมลู ท าการแปลง

ข้อมลูจากเคลวินไปเป็นองศาเซลเซียสโดยการน าไปลบด้วย -273.15 เพ่ือน าไปค านวณในดชันีภยั

แล้งและน ามาใช้ในการวิเคราะห์ข้อมลูตอ่ไป ดงัภาพ 3.4 
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3.3.2 ข้อมลูปริมาณน า้ฝนจากสถานี 

 1) รวบรวมข้อมูลปริมาณน า้ฝนรายวันจากศูนย์อุทกวิทยาชลประทานในพืน้ท่ี 5 จงัหวัด

ของลุ่มน า้น่านของประเทศไทย โดยใช้ช่วงระยะเวลา 10 ปี คือ พ.ศ. 2551 - 2560 ทัง้หมด7สถานี 

รายละเอียดข้อมลูประกอบด้วย จงัหวดั ชว่งเวลา ช่ือสถานี รหสัสถานี และปริมาณน า้ฝน 

 2) ตรวจสอบข้อมลูปริมาณน า้ฝนรายวนัจากสถานี ค านวณหาค่าเฉล่ียน า้ฝนสะสมรายปี 

และค่าสงูสดุและต ่าสดุของปริมาณน า้ฝนเพ่ือดคูวามสมัพนัธ์และความผนัแปรของปริมาณน า้ฝน

วา่เพิ่มขึน้หรือลดลง 

 3) น าพิกดัเข้าสู่โปรแกรมทางสารสนเทศภูมิศาสตร์เพ่ือน าต าแหน่งพิกดัสถานีตรวจวดัน้า

ฝนไปแสดงในรูปแบบของแผนท่ี โดยไปท่ี File > Add Data > Add XY Data >เลือกไฟล์พิกดัสถานี

ตรวจวดัน า้ฝน จากนัน้เลือก X Field: ให้เป็นลองจิจูด และ Y Field: ให้เป็นละติจูด และคลิก Edit 

ปรับแก้ระบบพิกดั โดยให้เลือก Geographic Coordinate System > World > WGS 1984  

ดงัภาพ 3.5 

 
ภาพ 3.1 การแปลงระบบพกัิด 
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ภาพ 3.2 ท าการตัดเฉพาะพืน้ท่ีศึกษา   

 

 
ภาพ 3.3 การตรวจสอบคุณภาพของข้อมูล NDVI 

 

 
ภาพ 3.4 การแปลงหน่วยเคลวินเป็นองสาเซลเซียส 
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ภาพ 3.5 น าพกัิดเข้าสู่โปรแกรมทางสารสนเทศภูมิศาสตร์ 
 

3.3.3 ผลิตภัณฑ์ TRMM3B42 

 1) ดาวน์โหลดผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ท่ีมีความละเอียดขนาด 0.25° x 0.25° 

ซึ่งได้มาจากข้อมลูดาวเทียม TRMM ทางเว็บไซต์ท่ีให้บริการโดย https://mirador.gsfc.nasa.gov/ 

ของ  National Aeronautics and Space Administration (NASA) ผู้ วิ จัย ต้องการดาว น์ โหลด

ผลิตภัณฑ์น า้ฝน โดยท าการก าหนดเขตพืน้ท่ีเป็นลุ่มน า้น่าน และเวลาท่ีต้องการคือปี พ.ศ.2550-

2560 ซึง่ผลิตภณัฑ์น า้ฝนนีเ้ป็นไฟล์นามสกลุ NetCDF (Network Common Data Form) หรือ .nc4 

 2) แปลงผลิตภณัฑ์น า้ฝนท่ีเป็นไฟล์นามสกลุ .nc4 ให้เป็น .tif ด้วยโปรแกรมทางสารสนเทศ

ภมูิศาสตร์ โดยใช้ Model Builder ดงัภาพ 3.6 เพ่ือช่วยลดการท างาน ซึ่ง Iterate Filesเป็นค าสัง่วน

ซ า้ ส่วน Multidimention > Make NetCDF Raster Layer เป็นการน าเข้าผลิตภัณฑ์น า้ฝนท่ีเป็น
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ไฟล์นามสกุล .nc4 และ Data Management Tools > Raster > Raster Dataset > Copy Raster 

เป็นการคดัลอกข้อมลูไฟล์ท่ีน าเข้าเพ่ือแปลงเป็นนามสกลุ .tif 

 3) สกัดข้อมูลปริมาณน า้ฝนจากผลิตภัณฑ์น า้ฝนท่ีแปลงไฟล์เป็นนามสกุล . tif แล้ว ณ 

ต าแหน่งพิกัดสถานีวดัน า้ฝนท่ีใช้ในการศึกษาทัง้ 10 ปี ด้วยโปรแกรมทางสารสนเทศภูมิศาสตร์ 

โดยใช้เคร่ืองมือใน ArcToolbox ไปท่ี Spatial Analyst Tools > Extraction > Extract Multi Values 

to Points ดงัภาพ 3.7 โดยต าแหนง่พิกดัสถานีวดัน า้ฝนท่ีน าเข้าจะเป็นชัน้ข้อมลูแบบจดุ  

 4) จัดข้อมูลปริมาณน า้ฝนรายวันจากผลิตภัณฑ์น า้ฝนให้อยู่ในรูปแบบท่ีเหมาะสม ใช้

โปรแกรม Microsoft excel 2013 เพ่ือหาคา่เฉล่ีย คา่ต ่าสดุ และสงูสดุ ของข้อมลูปริมาณน า้ฝนจาก

ผลิตภณัฑ์ TRMM3B42 เพ่ือน าไปใช้ในการวิเคราะห์ข้อมลูตอ่ไป 

 
ภาพ 3.6 การแปลงผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 โดยใช้ Model Builder 

 

 
 

ภาพ 3.7 การสกัดข้อมูลปริมาณน า้ฝนรายวันจากผลิตภัณฑ์น า้ฝน TRMM3B42 V.7  
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3.3.4 ข้อมูลพืน้ท่ีชลประทาน 

 1) ดาวน์โหลดข้อมลูพืน้ท่ีชลประทานจากเว็บไซต์ท่ีให้บริการโดย 

https://www.esri.com/th-th/arcgis/products/arcgis-online/overview ของ ArcGIS  

 2) น าข้อมลูเข้ามาในโปรแกรมทางสารสนเทศภมูิศาสตร์ ส าหรับท าแผนท่ีพืน้ท่ีชลประทาน

ในพืน้ท่ีลุม่น า้นา่น เพ่ือน าไปใช้ในการวิเคราะห์ข้อมลูตอ่ไป 

 
3.4 การวิเคราะห์ข้อมูล 

 3.4.1) ดชันีภยัแล้ง 

 1) NPA 

เปอร์เซ็นต์ปริมาณน า้ฝนตอ่เดือน (PA) หมายถึงปริมาณน า้ฝนลดลงเม่ือเทียบกบัคา่เฉล่ีย

ของชว่งเวลาเดียวกนั มนัคือค านวณโดยใช้สตูรตอ่ไปนี ้(Shao-E และ Bing-Fang, 2010) 

                                                      



P P

PA * 100%
P                         (สมการท่ี 3.3) 

โดยท่ี P หมายถึงปริมาณน า้ฝนในปัจจบุนั P คือปริมาณน า้ฝนท่ีอยูใ่นชว่งเวลาเดียวกนั PA 

สามารถใช้เพ่ือติดตามความแห้งแล้งได้ในระดบัหนึ่งค่าเบี่ยงเบนเทียบกับปริมาณน า้ฝนเฉล่ียค่า

ของ PA สามารถเป็นบวกหรือลบ เปอร์เซ็นต์ความผิดปกติของฝนท่ีมีค่าต่อเดือน(NPA) ท่ีมีค่า

ตัง้แต ่0 ถึง 1 หาได้จาก 

                                                       





min

max min

PA PA
NPA

PA PA                         (สมการท่ี 3.4) 

ท่ี PA min และ PA max เป็นค่าต ่าสุดและสงูสุดของNPA ตามล าดบั น าปริมาณน า้ฝนจาก

สถานีมาค านวณตามสูตรโดยใช้ โปรแกรม Microsoft Excel 2013 น าข้อมูลฝนจากสถานีมา

ค านวณโดยน าข้อมูลฝนแต่ละสถานีมาหาเฉล่ียในแตล่ะปี และน ามารวมกันเพ่ือหาค่าฝนของลุ่ม

น า้นา่นจากนัน้จงึน ามาใสใ่นดชันี 
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2) VHI 

สามารถใช้ข้อมูล NDVI และ LST ได้สร้างดชันีส าหรับการตรวจสอบความแห้งแล้ง VCI 

แสดงให้เห็นถึงภาวะปกติของค่า NDVI เทียบกับค่าสูงสุดและต ่าสุดของ NDVI TCI ใช้ค่าความ

สว่างเพ่ือประเมินความแห้งแล้งแทนของระดบัอุณหภูมิของพืช ค่า VHI ค านวณโดยการรวม VCI 

และ TCI ค านวณ VCI, TCI และ VHI ด้วยสตูรตอ่ไปนี ้(Kogan, 1998) 

                                        






min

max min

NDVI NDVI
VCI

NDVI NDVI                                     (สมการท่ื 3.5) 

                                        





min

max min

LST LST
TCI

LST LST                                       (สมการท่ี 3.6) 

                                    VHI a * VCI b * TCI                         (สมการท่ี 3.7) 

NDVImin และ NDVImax เป็นค่าต ่าสุดและสูงสุดของNDVI ตามล าดบั ส่วน LSTmin และ 

LSTmax มีค่าต ่าสุดและสูงสุด ค่า LST ตามล าดบั a และ b เป็นค่าสัมประสิทธ์ิน า้หนักของ VCI 

และ TCI เน่ืองจากมีส่วนร่วมของความชืน้และอณุหภูมิในช่วงพืชท่ีไม่ทราบแน่ชดัจึงต้องสมมติว่า

ค่าของ VCI และ TCI เท่ากับ (a = b = 0.5) VHI ของการศึกษาพืน้ท่ีตัง้แต่เดือนมกราคมถึงเดือน

ธันวาคมของช่วงเวลาทัง้หมด พ.ศ. 2551-พ.ศ.2560 โดยใช้เคร่ืองมือในโปรแกรมทางสารสนเทศ

ภูมิศาสตร์ ไปท่ี Spatial Analyst Tools > Extraction >  Map  Algebra > Raster Calculator ท า

การเลือกข้อมลูและค านวณตามสตูรดชันีท่ีก าหนด  

3) NVSWI 

เม่ือพืชต้องประสบกบัภยัแล้งโดยท่ีไม่มีน า้จะท าให้ปากใบปิดเพ่ือรักษาน า้ในพืชไว้ ดงันัน้

การคายระเหยจะลดลงตามการเพิ่มขึน้ของ LST สงัเกตเห็นได้จากพืชท่ีลดลงเน่ืองจากมีการคาย

ระเหยจากพืน้ดนิท่ีน้อยลง NVSWI ถกูสร้างขึน้และมีสตูรดงันี(้Carlson et al., 1994) 

                                                         
NDVI

VSWI
LST                                     (สมการท่ี 3.8) 

เน่ืองจาก VSWI สามารถแสดงต าแหน่งเชิงสมัพทัธ์ได้และไม่สามารถเทียบได้กบัชดุข้อมลู

เวลา NVSWI จงึถกูน ามาใช้และค านวณโดยใช้สตูรตอ่ไปนี ้(Abbaset al., 2014) 
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




min

max min

VSWI VSWI
NVSWI

VSWI VSWI             (สมการท่ี 3.9) 

ท่ี VSWImin และ VSWImax เป็นค่าต ่าสุดและสูงสุดของ VSWI ในช่วงระยะเวลาการศึกษา

ตามล าดบัค านวณจากช่วงเดือนมกราคม – ธันวาคมของ พ.ศ. 2551-พ.ศ.2560 ในพืน้ท่ีศึกษาลุ่ม

น า้น่าน โดยใช้เคร่ืองมือในโปรแกรมทางสารสนเทศภูมิศาสตร์ ไปท่ี Spatial Analyst Tools > 

Extraction >  Map  Algebra > Raster Calculator ท าการเลือกข้อมลูและค านวณตามสตูรดชันีท่ี

ก าหนด สงัเกตความแตกต่างของผลในแต่ละดชันีภัยแล้งท าการเปรียบเทียบทัง้ในช่วงเวลาและ

พืน้ท่ีท่ีประสบปัญหาภยัแล้งพร้อมทัง้ความรุนแรงในแตล่ะพืน้ท่ีว่าแตล่ะดชันีภยัแล้งมีความเหมือน

หรือแตกต่างกันมากน้อยเพียงใดท าการตรวจสอบหาค่าเฉล่ียเชิงพืน้ท่ีเ พ่ือดูแนวโน้มการ

เปล่ียนแปลงของภยัแล้ง และหาคา่สงูสดุและต ่าสดุของในแตล่ะดชันี 

 

3.4.2 การตรวจสอบความถูกต้องผลิตภัณฑ์ TRMM3B42 กับข้อมูลจากสถานีฝน 

การตรวจสอบความถูกต้องของผลิตภัณฑ์ TRMM3B42 ประจ าเดือนและข้อมูลปริมาณ

น า้ฝนจากสถานี น าไปเปรียบเทียบกบัข้อมูลและช่วงเวลา เพ่ือหาความสมัพนัธ์ของข้อมลูทัง้สอง

โดยใช้โปรแกรมMicrosoft Excel 2013 ไปท่ีข้อมูล > Data Analysis > Regression เลือกช่องดัง

ภาพ 3.8 จะได้ออกมาเป็นข้อมลูสถิตแิละกราฟท่ีแสดงความสมัพนัธ์ของข้อมลูทัง้สอง 

 

 

 

 

 

 

 

 

 

ภาพ 3.8 เคร่ืองมือหาความสัมพันธ์ของข้อมูล TRMM3B42 
 และข้อมูลฝนจากสถานีฝน
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บทที่ 4 
ผลการวิจัย 

การประเมินความถูกต้องดชันีภยัแล้งด้วยข้อมลูผลิตภัณฑ์ดาวเทียม ในการศกึษานีเ้ลือก

สามดัช นี คื อ  Normalized Monthly Precipitation Anomaly Percentage (NPA), Vegetation 

Health Index (VHI) และ Normalized Vegetation Supply Water Index (NVSWI) โดยใช้ข้อมูล

TRMM3B42 เข้ามาช่วยในการตรวจสอบ ระยะเวลาท่ีใช้ในการศึกษาคือสิบปี (พ.ศ.2551-พ.ศ.

2560) เพ่ือศกึษาความแตกตา่งของดชันีภยัแล้งทัง้สามตวัและต้องการหาดชันีภัยแล้งท่ีเหมาะสม

พืน้ท่ีศกึษาลุม่น า้นา่นมีผลการวิจยัโดยแบง่การวิเคราะห์ข้อมลูเป็น 5 สว่น ดงันี ้

4.1 การตรวจสอบและคดัเลือกข้อมลูท่ีใช้ในการศกึษา  

4.2 การตรวจสอบความถกูต้องผลิตภณัฑ์ TRMM3B42 กบัข้อมลูจากสถานีฝน 

4.3 การประเมินดชันีความแห้งแล้งทัง้สามดชันีในลุม่น า้นา่น 

4.4 การกระจายตวัของความแห้งแล้งในลุม่น า้นา่น 

4.5 แนวโน้มการเปล่ียนแปลงความแห้งแล้งในลุม่น า้นา่นในชว่งปี 2551-2560 

 

4.1 การตรวจสอบและคัดเลือกข้อมูลท่ีใช้ในการศึกษา 

 NDVI และ LST เป็นผลิตภัณฑ์ท่ีได้จากผลิตภัณฑ์ดาวเทียม MODIS (MOD13C2 และ

MOD11C3 ตามล าดับ) ซึ่งได้จากระบบสังเกตการณ์ของนาซ่าและระบบข้อมูลสารสนเทศเม่ือ

ตรวจสอบพบว่าข้อมูลผลิตภัณฑ์ NDVI ก่อนน ามาค านวณในดชันีภัยแล้งทัง้สองตัวควรน ามา

ตรวจสอบคณุภาพก่อนเพ่ือการค านวณผลท่ีมีประสิทธิภาพมากยิ่งขึน้แตเ่น่ืองจากข้อมลูท่ีผ่านการ

ตรวจสอบคณุภาพบางข้อมลูไม่ผ่านเกณฑ์จึงท าให้ข้อมลูในบางพืน้ท่ีไม่มีข้อมลูดงัภาพ 4.1 แสดง

ให้เห็นก่อนและหลงัตรวจสอบคณุภาพของข้อมูล จากการสงัเกตจึงพบว่าข้อมูลจะเร่ิมน้อยลงใน

เดือนมีนาคมและในเดือนมิถนุายนและกรกฎาคมจะเป็นชว่งท่ีมีข้อมลูน้อยท่ีสดุเน่ืองจากมีปริมาณ

เมฆฝนมากยากต่อการเก็บข้อมลูจากนัน้ข้อมูลจึงขึน้เร่ือยๆตามล าดบั ส่วนข้อมูล LST ควรแปลง

หนว่ยจากเคลวินเป็นองศาเซลเซียสก่อนจะน ามาท าการค านวณตามดชันีภยัแล้ง NVSWI และ VHI 

เพ่ือง่ายตอ่การวิเคราะห์ 
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 ตาราง 4.1 แสดงข้อมูล NDVI ที่ได้จากการเฉล่ียเชิงพืน้ท่ี 

 

เน่ืองจากการตรวจสอบคุณภาพของข้อมูลผลิตภัณฑ์ NDVI ท าให้บางส่วนของพืน้ท่ีไม่

แสดงข้อมลูเราจงึต้องน ามาเฉล่ียเชิงพืน้ท่ีเพ่ือท่ีจะได้ข้อมลู NDVI ของลุม่น า้นา่น เพ่ือน าไปค านวณ

ดชันีภัยแล้ง NVSWI และ VHI ข้อมูล NDVI ในตาราง 4.1จะแสดงค่าดชันีพืชพรรณในลุ่มน า้น่าน

โดยแสดงให้เห็นวา่คา่ NDVI จะสงูมากในเดือนตลุาคมโดยมีคา่มากท่ีสดุคือ 0.8165 และคา่ NDVI 

น้อยท่ีสุดอยู่ในเดือนเมษายนมีค่า 0.4002 หรือกล่าวคือในช่วงฤดฝูนเป็นช่วงท่ีค่า NDVI หรือดชันี

พืชพรรณมากท่ีสุดและในช่วงฤดูร้อนจะเป็นช่วงท่ีมีค่า  NDVI น้อยเน่ืองจากปริมาณน า้ท่ีมีไม่

เพียงพอหรือเกิดภยัแล้งโดยพืน้ท่ีลุ่มน า้น่านจะเป็นบริเวณท่ีมีคา่ NDVI สงูกระจายตวักนัเน่ืองจาก

มีน า้จากลุ่มน า้น่านจึงส่งผลให้พืชพรรณเจริญเติบโตได้ดีส่วนทางตอนบนของลุ่มน า้น่านเน่ืองจาก

เป็นภูเขาและห่างไกลจากแหล่งชลประทานจึงท าให้คา่ NDVI น้อยกว่าเห็นได้จากภาพ 4.1ท่ีแสดง

บริเวณทางตอนบนของลุ่มน า้นา่นท่ีมีสีเหลืองไปถึงส้มเป็นส่วนใหญ่และบริเวณส่วนล่างของลุ่มน า้

น่านก็มีสีเขียวเน่ืองจากเป็นบริเวณท่ีไม่ขาดแคลนน า้หรือประสบปัญหาภัยแล้งไม่รุนแรงมาก

เน่ืองจากมีน า้จากพืน้ท่ีชลประทานมาชว่ยบรรเทา 

 

NDVI 2551 2552 2553 2554 2555 2556 2557 2558 2559 2560 

มกราคม 0.593 0.595 0.684 0.626 0.632 0.597 0.693 0.589 0.632 0.698 

กุมภาพนัธ์ 0.570 0.543 0.575 0.585 0.627 0.641 0.599 0.569 0.553 0.586 

มีนาคม 0.618 0.532 0.516 0.620 0.581 0.594 0.530 0.525 0.643 0.584 

เมษายน 0.565 0.494 0.488 0.657 0.715 0.591 0.527 0.487 0.400 0.551 

พฤษภาคม 0.553 0.628 0.516 0.691 0.634 0.557 0.442 0.607 0.534 0.621 

มิถุนายน 0.687 0.737 0.575 0.687 0.554 0.635 0.652 0.578 0.624 0.712 

กรกฎาคม 0.698 0.752 0.691 0.748 0.590 0.704 0.719 0.657 0.685 0.725 

สิงหาคม 0.717 0.763 0.739 0.767 0.751 0.769 0.748 0.669 0.769 0.695 

กันยายน 0.705 0.750 0.729 0.675 0.752 0.748 0.726 0.734 0.765 0.739 

ตุลาคม 0.694 0.746 0.758 0.714 0.664 0.767 0.777 0.786 0.816 0.750 

พฤศจิกายน 0.693 0.698 0.688 0.688 0.697 0.732 0.694 0.716 0.707 0.727 

ธันวาคม 0.632 0.616 0.631 0.645 0.706 0.652 0.630 0.716 0.656 0.666 



 
29 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

ก.                                                     ข. 
ภาพ 4.1 ภาพ ก. แสดงข้อมูล NDVI ก่อนที่จะน าไปตรวจสอบคุณภาพของเดือน

มกราคมปี พ.ศ.2551 กับภาพ ข.แสดงข้อมูลท่ีผ่านการน าไปตรวจสอบคุณภาพแล้วของ
เดือนมกราคมปี พ.ศ.2551 

 ในส่วนผลิตภัณฑ์ LST ซึ่งเป็นข้อมูลอุณหภูมิพืน้ผิวดิน จากภาพ 4.2 แสดงให้เห็นว่าใน

บริเวณทางตอนลา่งของลุม่แม่น า้น่านเน่ืองจากบริเวณตอนล่างของลุม่แม่น า้นา่นส่วนใหญ่เป็นเขต

เมืองจึงท าให้มีการปล่อยความร้อนออกมาเน่ืองจากกิจกรรมของมนุษย์เพราะมีความสัมพันธ์

ระหว่างอณุหภูมิพืน้ผิวดินกบัพืน้ท่ีเมือง ส่วนทางตอนบนของลุ่มน า้น่านเน่ืองจากเป็นภูเขาและป่า

จึงท าให้อุณหภูมิผิวดินไม่สูงมากโดยจากตาราง 4.2 แสดงให้เห็นว่าอุณหภูมิผิวดินจะสูงท่ีสุดใน

เดือนเมษายนซึ่งตรงกบัช่วงหน้าร้อนโดยมีคา่อณุหภูมิผิวดินสงูถึง 38 องศาเซลเซียส และในเดือน

ธนัวาคมเป็นชว่งท่ีมีอณุหภมูิน้อยท่ีสดุโดยมีอณุหภมูิผิวดนิอยูท่ี่ 24 องศาเซลเซียส 
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ตาราง 4.2 แสดงข้อมูล LST ที่ได้จากการเฉล่ียชิงพืน้ท่ี (℃) 

 

 

 

 

   

 

 
 

 

 

 

 

 

 

 

 

  

ก.                                                                                     ข. 

ภาพ 4.2 ภาพ ก. แสดงอุณหภูมิพืน้ผิวในเดือนเมษายน พ.ศ.2559 และ 
ภาพ ข. แสดงอุณหภูมิพืน้ผิวในเดือนธันวาคม พ.ศ.2559 

 

LST 2551 2552 2553 2554 2555 2556 2557 2558 2559 2560 
มกราคม 28.52 26.33 27.60 26.57 27.55 27.55 27.42 26.54 28.37 27.98 
กุมภาพนัธ์ 29.08 30.82 31.17 29.56 30.69 30.69 30.63 30.27 29.38 30.72 
มีนาคม 32.62 32.93 33.49 30.40 32.76 32.76 33.32 33.61 34.65 33.69 
เมษายน 34.61 33.44 36.73 31.70 33.75 33.75 35.85 34.77 38.29 34.62 
พฤษภาคม 32.59 32.78 36.00 30.27 35.19 34.33 34.96 34.99 36.99 33.30 
มิถุนายน 29.77 27.87 33.21 28.10 29.56 29.56 31.19 32.71 31.33 29.76 
กรกฎาคม 28.37 27.11 31.01 28.71 28.96 28.96 30.85 29.39 28.62 28.42 
สิงหาคม 28.25 28.43 29.13 28.07 27.45 27.45 28.05 28.73 29.13 28.19 
กันยายน 28.06 28.77 27.24 27.43 27.43 27.43 27.27 28.39 26.72 28.37 
ตุลาคม 27.62 27.70 26.51 27.54 28.49 28.49 28.22 28.41 27.77 27.50 

พฤศจิกายน 25.49 27.69 27.16 27.52 28.42 28.42 27.79 27.88 28.28 27.37 
ธันวาคม 26.12 27.22 26.49 26.25 27.92 27.92 24.65 27.18 27.68 26.49 
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4.2 การตรวจสอบความถูกต้องผลิตภัณฑ์ TRMM3B42 กับข้อมูลจากสถานีฝน 
การตรวจสอบความถูกต้องของผลิตภัณฑ์ TRMM3B42 ประจ าเดือนและข้อมูลปริมาณ

น า้ฝนจากสถานี ในการศกึษานีผ้ลิตภณัฑ์ TRMM3B42 แสดงให้เห็นถึงความสอดคล้องกนัในบาง

เดือนและมีการค่าสูงบางในช่วงฤดูหนาวและมีค่าต ่าไปบางในช่วงฤดูร้อน ในภาพ 4.3 เม่ือน า

ข้อมูล TRMM3B42 ไปเปรียบเทียบกับข้อมูลและเวลาของปริมาณน า้ฝนจากสถานี  พบว่า 

TRMM3B42 มีความสมัพนัธ์ท่ีคอ่นข้างดีและมีนยัส าคญักบัคา่สมัประสิทธ์ิสหสมัพนัธ์ 0.484 มีคา่

สมัประสิทธ์ิสหสมัพนัธ์ใกล้บวกหนึ่งแสดงว่าตวัแปรทัง้สองมีความสมัพนัธ์กนัโดยตรงอย่างมาก มี

การเบี่ยงเบนของข้อมูลฝนจากสถานีและผลิตภัณฑ์จาก TRMM3B42  ดังนัน้ผลิตภัณฑ์ 

TRMM3B42 สามารถใช้เป็นตวัวดัเพ่ือหาลกัษณะฝนในเชิงพืน้ท่ีของลุม่น า้นา่นได้ 
 

 
 

ภาพ 4.3 ความสัมพันธ์ระหว่างข้อมูล TRMM3B42 กับปริมาณน า้ฝนจากสถานี 

 

 

 

Y = 0.03 * x + 2.4 

R = 0.484 

R2 = 0.234 

Y = 0.03 * x + 2.4 
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ตาราง 4.3 เกณฑ์ความแห้งแล้ง 
ระดับ ความแห้งแล้ง 

0 – 0.20 แล้งรุนแรง 
0.21 - 0.40 แล้งปานกลาง 
0.41 – 0.60 แล้งเลก็น้อย 
0.61 – 0.80 ปกต ิ

0.81 - 1 ชืน้ 

 

4.3 การประเมินดัชนีความแห้งแล้งทัง้สามดัชนีในลุ่มน า้น่าน 

           เพ่ือเลือกดชันีท่ีเหมาะสมท่ีสุดกับลุ่มน า้น่าน ผลจากดชันีท่ีใช้ในการศึกษาสามตวั  (NPA, 

VHI และ NVSWI) จะได้รับการประเมินจากการวิ เคราะห์ความสัมพันธ์โดยการใช้ข้อมูล

TRMM3B42 เพ่ือศกึษาความแห้งแล้งในทัง้สามดชันี NVSWI, VHI และ NPA จงึได้แบง่ระดบัความ

แห้งแล้งไว้ห้าระดบัตามตาราง 4.3 โดยจะน าผลท่ีได้จากการค านวณดชันีแต่ละตวัมาเทียบตาม

เกณฑ์เพ่ือวิเคราะห์ความแห้งแล้งท่ีเกิดขึน้ในแตล่ะดชันีโดยดชันีภยัแล้งทัง้สามตวัผลท่ีได้หลงัจาก

น าข้อมูลไปค านวณตามสูตรผลท่ีได้ออกมาไม่เหมือนกันจากนัน้จึงน าผลท่ีได้มาวิเคราะห์หา

ความสมัพนัธ์ของดชันีทัง้สามและข้อมูล TRMM3B42 โดยเร่ิมจากดชันี NPA ซึ่งเป็นการค านวณ

เปอร์เซ็นต์ความคลาดเล่ือนต่อเดือนของปริมาณน า้ฝน โดยในดชันีนีจ้ะน าปัจจัยในเร่ืองปริมาณ

น า้ฝนเข้ามาช่วยในการตรวจสอบความแห้งแล้ง โดยใช้ปริมาณน า้ฝนจากสถานีในลุ่มน า้น่าน

ทัง้หมด 7 สถานี จากตาราง 4.4 แสดงให้เห็นวา่เดือนมกราคมไปจนถึงเดือนมีนาคมมีคา่ NPA คอ่ย

ข้างต ่าและเพิ่มสูงขึน้ในเดือนเมษายนไปจนถึงเดือนกันยายน จากนัน้จึงคอ่ยลดลงมาจนถึงเดือน

ธันวาคม โดยค่า NPA ท่ีมากท่ีสุดมีค่าเท่ากับหนึ่งและมีค่าต ่าสุดเท่กับศนูย์ โดยเดือนท่ีมีค่า NPA 

มากท่ีสุดคือเดือนมิถุนายน และกรกฎาคม  จากผลเฉล่ียของดชันี NPA จากช่วงเวลาตัง้แต่ พ.ศ.

2551-พ.ศ.2560 พบว่าผลของค่าดชันี NPA ในปีพ.ศ.2551-พ.ศ.2552 มีค่าต ่ามากและเพิ่มขึน้มา

ในปีพ.ศ.2553หลงัจากนัน้ในแตล่ะปีมีคา่ไมแ่ตกตา่งกนัมากนกั โดยมีคา่สงูสดุท่ี 0.5504 ในปี พ.ศ.

2553 และค่าต ่าสุดอยู่ท่ี 0.1369 ในปี พ.ศ. 2551 ข้อด้อยของดชันีนีคื้อไม่สามารถตรวจสอบการ

กระจายเชิงพืน้ท่ีได้และเป็นการตรวจสอบความแห้งแล้งจากปริมาณน า้ฝนเท่านัน้จึงส่งผลให้ใน

บางเดือนท่ีไมมี่ฝนมีคา่ตา่งไปเล็กน้อย 
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ตาราง 4.4 แสดงผลเฉล่ียของดัชนี NPA จากช่วงเวลาตัง้แต่พ.ศ.2551-พ.ศ.2560 

 

 
ภาพ 4.4 ความสัมพันธ์ระหว่าง NPA และ TRMM3B42 

NPA 2551 2552 2553 2554 2555 2556 2557 2558 2559 2560 
มกราคม 0 0.633 0.011 0.194 0.194 0 0.512 1 0.569 0 
กุมภาพนัธ์ 0.110 0.379 0.845 0.154 0 0.201 1 0.032 0.009 0 
มีนาคม 0.084 0.019 1 0.17 0.176 0.147 0.246 0.016 0.199 0 
เมษายน 0.204 0.194 0.194 0.856 0.578 0.612 0.692 0.529 0 1 
พฤษภาคม 0.068 0 0.184 0.599 0.599 0.368 0.398 0.264 0.588 1 
มิถุนายน 0 0.138 0.471 0.664 0.298 0.981 0.656 0.292 1 0.839 
กรกฎาคม 0 0.205 0.510 0.766 0.766 0.560 0.482 0.351 0.687 1 
สิงหาคม 0 0.307 0.387 0.708 0.387 0.429 0.753 0.292 1 0.860 
กันยายน 0 0.005 1 0.984 0.984 0.707 0.316 0.267 0.311 0.626 
ตุลาคม 0.173 0.220 1 0.359 0.158 0.416 0.364 0.401 0.571 0 

พฤศจิกายน 1 0.006 0 0.442 0.442 0.546 0.341 0.679 0.459 0.133 
ธันวาคม 0 0 1 0.028 0.041 0.362 0.003 0.435 0.001 0 

Y = 0.1667 * x + -0.4 

R = 0.299 

R2 = 0.089 

Y = 0.03 * x + 2.4 
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              จากภาพ 4.4 แสดงให้เห็นความสมัพนัธ์ระหวา่ง NPA และ TRMM3B42 มีคา่สมัประสิทธ์ิ

สหสมัพนัธ์เทา่กบั 0.299 ซึง่หมายความตวัแปรสองตวัมีความสมัพนัธ์กนัเน่ืองจากมีคา่สมัประสิทธ์ิ

สหสมัพนัธ์เข้าใกล้บวกหนึง่ แตมี่ความสมัพนัธ์กนัน้อยมาก 

ตาราง 4.5 แสดงผลเฉล่ียของดัชนี VHI จากช่วงเวลาตัง้แต่พ.ศ.2551-พ.ศ.2560  

VHI 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 

มกราคม 0.517 0.027 0.725 0.222 0.476 0.315 0.728 0.047 0.662 0.877 
กุมภาพนัธ์ 0.136 0.416 0.665 0.330 0.706 0.885 0.655 0.417 0.123 0.614 
มีนาคม 0.626 0.359 0.363 0.408 0.533 0.585 0.399 0.416 1.000 0.654 
เมษายน 0.480 0.280 0.521 0.404 0.866 0.455 0.515 0.370 0.500 0.458 
พฤษภาคม 0.395 0.558 0.575 0.500 0.751 0.533 0.348 0.682 0.622 0.584 
มิถุนายน 0.539 0.500 0.557 0.384 0.237 0.379 0.578 0.519 0.514 0.609 
กรกฎาคม 0.495 0.500 0.812 0.693 0.237 0.588 0.877 0.495 0.486 0.559 
สิงหาคม 0.477 0.761 0.849 0.673 0.582 0.467 0.574 0.379 0.997 0.350 
กันยายน 0.492 0.916 0.427 0.174 0.599 0.578 0.413 0.734 0.500 0.755 
ตุลาคม 0.376 0.569 0.310 0.425 0.500 0.839 0.804 0.883 0.817 0.530 

พฤศจิกายน 0.053 0.492 0.286 0.345 0.605 1.000 0.461 0.725 0.696 0.769 
ธันวาคม 0.303 0.392 0.359 0.391 0.451 0.681 0.072 0.886 0.661 0.532 

 

              ตอ่มาเป็นดชันี VHI ซึง่เป็นดชันีท่ีค านงึถึงสขุภาพของพืชโดยใช้ข้อมลู NDVI และ LST มา

สร้างดชันีส าหรับการตรวจสอบความแห้งแล้ง โดยจะแสดงให้เห็นถึงภาวะปกติของคา่ NDVI จาก

ตาราง 4.5 เดือนท่ีมีคา่ดชันี VHI มากท่ีสดุคือเดือนมีนาคมและเดือนพฤศจิกายนโดยมีคา่ดชันี  VHI 

เทา่กบั 1 และเดือนท่ีน้อยท่ีสดุคือเดือนมกราคมโดยมีคา่ดชันี VHI เทา่กบั 0.0278 จากตาราง 4.5 

แสดงให้เห็นว่าค่า VHI มีแนวโน้มท่ีเพิ่มสูงขึน้ทุกปี โดยมีเพียงลดต ่าลงในปีพ.ศ.2551 และพ.ศ.

2554 จากภาพ 4.5 แสดงค่าดชันี VHI ในแต่ละเดือนของปีพ.ศ.2558 จะสงัเกตได้ว่าจะไม่มีข้อมูล

ในบางพืน้ท่ีเน่ืองจากได้มีการตรวจข้อมลูก่อนท่ีจะน ามาค านวณดชันีข้อมลูโดยพบว่าข้อมลูจะเร่ิม

น้อยลงในเดือนพฤษภาคมและเร่ิมเพิ่มขึน้ในเดือนกนัยายน จากค่าดชันีท่ีเห็นจากภาพ 4.5 แสดง

ให้เห็นว่าพืน้ท่ีส่วนใหญ่ของลุ่มน า้น่านประสบกับปัญหาภัยแล้งและในบางพืน้ท่ีของลุ่มน า้น่าน

ตอนล่างประสบกบัปัญหาภยัแล้งท่ีรุนแรง ซึ่งขดัแย้งกบัข้อมลูท่ีกลา่วว่าบริเวณตอนล่างของลุ่มน า้

น่านเป็นพืน้ท่ีเขตชลประทาน เน่ืองจากค่าของ NDVI และ LST แตกต่างกันมากในหลายเดือน 

(Kogan, 1998) 
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                   จากภาพ 4.6 แสดงให้เห็นความสัมพันธ์ระหว่าง VHI และ TRMM3B42 มีค่า

สมัประสิทธ์ิสหสมัพนัธ์เทา่กบั -0.311 ซึ่งหมายความตวัแปรสองตวัมีความสมัพนัธ์กนัในเชิงตรงกนั

ข้ามเน่ืองจากมีค่าสมัประสิทธ์ิสหสมัพนัธ์เข้าใกล้ลบหนึ่ง และต่อมาดชันีตวัสุดท้าย NVSWI เป็น

ดชันีท่ีเอาปัจจัยเก่ียวกับการคายระเหยของพืชอนัเน่ืองมาจากอุณหภูมิผิวดินท่ีเพิ่มขึน้หรือลงจะ

สง่ผลตอ่ปริมาณการคายระเหยของพืช เม่ืออณุหภมูิผิวดนิเพิ่มสงูขึน้จะท าให้ปากใบของพืชปิดเพ่ือ

รักษาน า้ในพืชไว้ดงันัน้การคายนะเหยจะลดลงตามการเพิ่มขึน้ของอณุหภูมิผิวดิน จากตาราง 4.6 

แสดงให้เห็นว่ามีคา่ดชันี NVSWI สงูท่ีสดุในเดือนตลุาคมโดยมีค่าเท่ากบั 0.0312 และมีคา่น้อยใน

เดือนกมุภาพนัธ์มีคา่เท่ากบั 0.0021 จากผลเฉล่ียของดชันี NVSWI จากช่วงเวลาตัง้แต ่พ.ศ.2551-

พ.ศ.2560 พบว่าผลของค่าดชันี NVSWI ในแต่ละปีมีค่าไม่แตกต่างกันมาก เม่ือไปดูผลเชิงพืน้ท่ี

สามารถแบ่งการวิเคราะห์ได้ออกเป็นสามส่วนได้แก่ ส่วนตอนบนของลุ่มน า้น่านเป็นพืน้ท่ีราบสูง

เป็นเขตธรรมชาติ อยู่ห่างจากเขตชลประทานผลจึงประสบปัญหาภยัแล้งมากกว่าบริเวณอ่ืนในลุ่ม

น า้น่าน ส่วนบริเวณตอนกลางของลุ่มน า้น่านเป็นส่วนพืน้ท่ีท่ีอยู่ ระหว่างธรรมชาติและพืน้ท่ี

ชลประทานจึงท าให้ประสบปัญหาภัยแล้งบางพืน้ท่ีแต่ไม่มากเท่าตอนบนของลุ่มน า้น่าน ความ

รุนแรงของภยัแล้งยงัไม่มากเทา่เน่ืองจากยงัพอมีน า้จากพืน้ท่ีชลประทานบาง สว่นตอนล่างของลุ่ม

น า้น่านนัน้ปัญหาภัยแล้งแทบไม่ได้รับผลกระทบเน่ืองจาก อยู่ในพืน้ ท่ีชลประทานจึงท าให้ความ

รุนแรงของภยัแล้งน้อยเพราะสามารถดงึน า้จากชลประทานมาบรรเทาได้ 

                   จากภาพ 4.7 จะเห็นว่าผลท่ีได้นัน้แตกตา่งจากคา่ดชันี VHI มากเน่ืองจากในดชันี VHI 

แสดงออกมาว่าทัว่ลุ่มน า้น่านประสบปัญหากบัภยัแล้งแต่ผลจากดชันีNVSWI แสดงให้เห็นว่าทาง

ตอนล่างของลุ่มน า้น่านไม่ได้สบปัญหาภัยแล้งท่ีรุนแรงซึ่งตรงกับข้อมูลท่ีกล่าวว่าลุ่มน า้น่าน

ตอนล่างอยู่ในบริเวณพืน้ท่ีชลประทาน โดยตัง้แต่เดือนพฤษภาคมข้อมูลจะผ่านการเกณฑ์การ

ตรวจสอบคณุภาพได้น้อยอนัเน่ืองมาจากปัญหาจากปริมาณเมฆฝนไปจนถึงเดือนกนัยายน ใช้การ

เฉล่ียเชิงพืน้ท่ีเพ่ือท่ีจะได้ดแูนวโน้มของการภยัแล้งจากดชันี NVSWI 
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       มกราคม 2558              กุมภาพันธ์ 2558                มีนาคม 2558            เมษายน 2558 

 
 
 
 
                                                                                                       
       
 
 
       พฤษภาคม 2558          มิถุนายน 2558             กรกฎาคม 2558           สิงหาคม 2558 
 
 
                                              
 
 
 
                                                                                                           
     กนัยายน 2558                     ตุลาคม 2558               พฤศจิกายน 2558          ธันวาคม 2558 

 
 

ภาพ 4.5 ดัชนี VHI พ.ศ.2558  
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ภาพ 4.6 ความสัมพันธ์ระหว่าง VHI และ TRMM3B42 

                    

ตาราง 4.6 แสดงผลเฉล่ียของดัชนี NVSWI จากช่วงเวลาตัง้แต่ พ.ศ.2551-พ.ศ.2560 

 

NVSWI 2551 2552 2553 2554 2555 2556 2557 2558 2559 2560 
มกราคม 0.022 0.023 0.028 0.024 0.023 0.022 0.028 0.023 0.024 0.027 
กมุภาพนัธ์ 0.021 0.017 0.018 0.020 0.022 0.022 0.021 0.002 0.019 0.020 
มีนาคม 0.021 0.017 0.016 0.021 0.018 0.019 0.016 0.016 0.021 0.018 
เมษายน 0.017 0.014 0.013 0.022 0.025 0.018 0.015 0.014 0.010 0.016 
พฤษภาคม 0.017 0.020 0.015 0.023 0.019 0.017 0.011 0.018 0.013 0.019 
มิถนุายน 0.023 0.026 0.017 0.024 0.016 0.022 0.021 0.017 0.020 0.024 
กรกฎาคม 0.024 0.027 0.023 0.026 0.018 0.025 0.024 0.023 0.024 0.023 
สงิหาคม 0.024 0.027 0.025 0.028 0.027 0.026 0.026 0.022 0.026 0.024 
กนัยายน 0.024 0.026 0.026 0.022 0.027 0.029 0.026 0.025 0.028 0.026 
ตลุาคม 0.024 0.026 0.028 0.026 0.022 0.028 0.028 0.027 0.031 0.027 

พฤศจิกายน 0.028 0.025 0.026 0.025 0.024 0.027 0.025 0.025 0.025 0.027 
ธนัวาคม 0.025 0.023 0.024 0.025 0.026 0.023 0.026 0.025 0.024 0.026 

Y = 0.0833 * x + 0.15 

R = - 0.311 

R2 = 0.097 

Y = 0.03 * x + 2.4 
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ภาพ 4.7 ดัชนี NVSWI พ.ศ.2558 

   มกราคม 2558           กมุภาพนัธ์ 2558          มีนาคม 2558            เมษายน 2558 

    พฤษภาคม 2558       มิถนุายน 2558           กรกฎาคม 2558          สิงหาคม 2558 

    กนัยายน 2558           ตลุาคม 2558             พฤศจิกายน 2558         ธนัวาคม 2558 
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ภาพ 4.8 ความสัมพันธ์ระหว่าง NVSWI และ TRMM3B42 

                   จากภาพ4.8 แสดงให้เห็นความสัมพันธ์ระหว่าง  NVSWI และ TRMM3B42 มีค่า

สมัประสิทธ์ิสหสมัพนัธ์เท่ากบั 0.792 ซึง่หมายความตวัแปรสองตวัมีความสมัพนัธ์กนัมากเน่ืองจาก

มีค่าสัมประสิทธ์ิสหสมัพันธ์เข้าใกล้บวกหนึ่ง จากผลการวิเคราะห์ความสมัพนัธ์ของดชันีภัยแล้ง

และTRMM3B42แล้วพบว่า NVSWI มีความสอดคล้องมากกว่าดชันีตวัอ่ืนเน่ืองจากผลท่ีออกมามี

การค านึงถึงการอยู่ใกล้ไกลของแหล่งน า้โดย (Cong et al., 2016) NVSWI ถูกระบุว่าเป็นดัชนีท่ี

เหมาะสมท่ีสดุในสามดชันีในการศกึษาครัง้นีไ้ด้ใช้ NVSWI เพ่ือตดิตามความแห้งแล้ง NVSWI มีตวั

บ่งชีท่ี้ตรงตาวตัถุประสงค์มากกว่า  โดย NPA ตรวจสอบความแห้งแล้งหลงัจากฝนตกเท่านัน้ซึ่ง

อาจมีความแตกตา่งเล็กๆน้อยในบางเดือนท่ีมีฝนตกและมีข้อด้อยคือไม่อาจดกูารกระจายเชิงพืน้ท่ี

ได้ส่วนในดชันีVHI เน่ืองจากค่าของ NDVI และ LST แตกต่างกันอย่างมากในหลายเดือน จึงท า

ให้ผลท่ีได้มีความรุนแรงของภยัแล้งเกินจริง และเม่ือดจูากการวิเคราะห์ความสมัพนัธ์ระหวา่งข้อมลู

TRMM3B42 และดชันีทัง้สามพบว่า ดัชนี NPA และ NVSWIมีค่าสัมประสิทธ์ิสหสัมพันธ์เท่ากับ 

0.8344 ซึ่งมีความสัมพันธ์กับข้อมูลTRMM3B42เน่ืองจากเข้าใกล้บวกหนึ่ง ส่วนดัชนี VHI มีค่า

สัมประสิทธ์ิสหสัมพันธ์เท่ากับ -0.4311 ซึ่งหมายความตวัแปรสองตัวมีความสัมพันธ์กันในเชิง

Y = 0.1333 * x + 0 

R = 0.792 

R2 = 0.627 

Y = 0.03 * x + 2.4 
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ตรงกันข้ามเน่ืองจากมีค่าสัมประสิทธ์ิสหสมัพันธ์เข้าใกล้ลบหนึ่ง แต่เน่ืองจากดชันีNPAไม่มีการ

กระจายเชิงพืน้ท่ีจงึท าให้ดชันี NVSWI เหมาะกบัพืน้ท่ีศกึษาลุม่น า้นา่นมากท่ีสดุ 

4.4 การกระจายตัวของความแห้งแล้งในลุ่มน า้น่าน 

                 การกระจายตวัของความแห้งแล้งในลุ่มน า้น่านถกูค านวณจากดชันี NVSWI จากภาพ

4.10 แสดงการกระจายเชิงพืน้ท่ีของ NVSWI ในชว่ง 5 เดือน (มกราคมมีนาคมพฤษภาคมกนัยายน

และพฤศจิกายน)ชองสามปี แสดงให้เห็นว่าลุ่มน า้นา่นจะประสบปัญหามากในบริเวณทางตอนบน

ของลุ่มน า้น่านเน่ืองจากมีพืน้ท่ีเป็นภูเขาและห่างจากเขตพืน้ท่ีชลประทานท าให้ขาดแคลนน า้ได้

และเม่ือประสบปัญหาภัยแล้งจึงส่งผลรุนแรงกว่าพืน้ท่ีอ่ืน ในทางตอนล่างของลุ่มน า้น่านประสบ

ปัญหาภัยแล้งไม่รุนแรงมากนกัเน่ืองจากอยู่ในพืน้ท่ีชลประทานเม่ือเกิดภัยแล้งจึงมีแหล่งน า้จาก

ชลประทานมาช่วยบรรเทา เม่ือเวลาผ่านไปในเดือนมีนาคมความแห้งแล้งในลุ่มน า้น่านได้เพิ่มขึน้ 

โดยบริเวณทางตอนบนของลุ่มน า้น่านได้รับผลกระทบ ในเดือนพฤษภาคมเน่ืองจากมีฝนตกลงมา

จึงท าให้ปริมาณน า้ฝนเพิ่มขึน้จึงช่วยบรรเทาภัยแล้งได้ ในเดือนกรกฎาคมและเดือนกันยายนเม่ือ

ปริมาณน า้ฝนมากท่ีสดุท าให้ภยัแล้งในลุม่น า้นา่นลดลง และจะมาเพิ่มขึน้ในเดือนพฤศจิกายน จาก

ภาพท่ี4.9 แสดงปริมาณน า้ฝนของทัง้ปี เห็นได้วา่ปริมาณน า้ฝนมีความสมัพนัธ์กบัภยัแล้ง 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพ 4.9 ปริมาณน า้ฝนรายเดือน 
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ภาพ 4.10 แสดงการกระจายเชิงพืน้ที่ของ NVSWI ในช่วง 5 เดือน (มกราคมมีนาคม
พฤษภาคมกันยายนและพฤศจิกายน) 

 

                          มกราคม 2551      มีนาคม 2551      พฤษภาคม 2551     กนัยายน 2551    พฤศจิกายน 2551 

 

                          มกราคม 2560      มีนาคม 2560      พฤษภาคม 2560     กนัยายน 2560    พฤศจิกายน 2560 

 

                          มกราคม 2556      มีนาคม 2556      พฤษภาคม 2556     กนัยายน 2556    พฤศจิกายน 2556 
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4.5 แนวโน้มการเปล่ียนแปลงความแห้งแล้งในลุ่มน า้น่านในช่วงปี 2551-2560 

จากภาพ 4.11 แสดงการเปล่ียนแปลงการเกิดภยัแล้งในลุ่มน า้น่านพบว่ามีภัยแล้งสงูท่ีสุด

ในปี พ.ศ.2554 และภัยแล้งต ่าสุดปี พ.ศ.2558 โดยจะเห็นว่าในลุ่มน า้น่านมีแนวโน้มท่ีจะเกิดภัย

แล้งเพิ่มสงูขึน้ จากกราฟแสดงให้เห็นว่าภยัแล้งเกิดขึน้ทกุปีแตมี่ความรุนแรงไม่เทา่กนั รูปแบบของ

ภยัแล้งได้รับอิทธิพลจากการแปรผกผนัของปริมาณน า้ฝนและการแปรปรวนของฤดกูาร จากภาพ 

4.12 ผลกระทบจากภัยแล้งจะรุนแรงหรือไม่ขึน้อยู่กับการใกล้พืน้ท่ีชลประทาน เน่ืองจากการพืน้ท่ี

หา่งจากพืน้ท่ีชลประทานมีโอกาสขาดแคลนน า้มากกวา่ 

 
ภาพ 4.11 แนวโน้มการเปล่ียนแปลงของความแห้งแล้ง 

 

 

 

 

 

 

 

 

 
ภาพ 4.12 พืน้ท่ีชลประทานในลุ่มน า้น่าน 
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บทที่ 5 
สรุปและอภปิรายผลการศึกษา 

การศึกษาการประเมินความถูกต้องดชันีภยัแล้งด้วยข้อมูลผลิตภัณฑ์ดาวเทียมในพืน้ท่ี 5 

จังหวัดลุ่มแม่น า้น่าน ดัชนีภัยแล้งท่ีใช้ในการศึกษานีมี้สามดัชนีคือ Normalized Monthly 

Precipitation Anomaly Percentage (NPA), Vegetation Health Index (VHI) และ  Normalized 

Vegetation Supply Water Index (NVSWI) โดยท าการประเมินจากการใช้ข้อมูลฝน TRMM3B42 

V.7 จากดาวเทียม TRMM เพ่ือหาความสมัพนัธ์จากข้อมลู TRMM และดชันีภยัแล้งทัง้สาม เพ่ือเป็น

ประโยชน์ตอ่การเลือกดชันีภยัแล้งท่ีเหมาะสมกบัลุม่น า้นา่น 

5.1 สรุปและอภปิรายผลการวิจัย 

 จากการศกึษาการประเมินความถกูต้องดชันีภยัแล้งทัง้สามตวัได้แก่ Normalized Monthly 

Precipitation Anomaly Percentage (NPA), Vegetation Health Index (VHI) และ  Normalized 

Vegetation Supply Water Index (NVSWI) โดยการดจูากความสมัพนัธ์ของข้อมลูฝน TRMM3B42 

และดชันีทัง้สามตวั เพ่ือหาดชันีภัยแล้งท่ีดีท่ีสุดและน ามาหาการเปล่ียนแปลงและการกระจายตวั

ของภยัแล้งในลุม่น า้นา่น สามารถสรุปผลตามวตัถปุระสงค์วิจยัได้ดงันี ้

5.1.1 การตรวจสอบความถูกต้องผลิตภัณฑ์ TRMM3B42 กับข้อมูลจากสถานีฝน 

 ในการตรวจสอบฝนจากสถานีและTRMM พบว่าพบว่า ปริมาณน า้ฝนท่ีตรวจวัดด้วย

ดาวเทียมมีคา่มากกว่าฝนเป็นส่วนใหญ่ ซึ่งจะตา่งกนัตามปริมาณและความแรงของน า้ฝนท่ีเกิดขึน้

ในแต่ละปี (อภิษฐา ยอดยิ่ง, 2559) จากการตรวจสอบความถูกต้องผลิตภัณฑ์ TRMM3B42 กับ

ข้อมูลจากสถานีฝนแสดงให้เห็นถึงความสอดคล้องกันในบางเดือนและมีการค่าสูงบางในช่วงฤดู

หนาวและมีค่าต ่าไปบางในช่วงฤดูร้อน โดยความสัมพันธ์ของข้อมูลทัง้สองมีความสัมพันธ์ท่ี

คอ่นข้างดีและมีนยัส าคญักบัคา่สมัประสิทธ์ิสหสมัพนัธ์ 0.484 มีคา่สมัประสิทธ์ิสหสมัพนัธ์ใกล้บวก

หนึ่งแสดงว่าตวัแปรทัง้สองมีความสัมพันธ์กันโดยตรงในทิศทางเดียวกัน สามารถใช้ผลิตภัณฑ์ 

TRMM3B42 เป็นตวัวดัเพ่ือหาฝนเชิงพืน้ท่ีของลุม่น า้นา่นได้  

5.1.2 การประเมินดัชนีความแห้งแล้งทัง้สามดัชนีในลุ่มน า้น่าน 

การประเมินความถูกต้องของดัช นีทัง้สามตัว  NPA VHI และ NVSWI โดยการหา

ความสมัพนัธ์กบัผลิตภณัฑ์ฝนจาก TRMM3B42 V.7 พบวา่ดชันีท่ีมีความสมัพนัธ์กบัข้อมลูดงักลา่ว

มากท่ีสุด คือดชันี NVSWI โดยมีคา่สหสมัพนัธ์เท่ากับ 0.792 มีความสมัพนัธ์เชิงบวกและจากการ

วิเคราะห์เชิงพืน้ท่ีพบว่าสอดคล้องกบัข้อมลูพืน้ท่ีชลประทาน เป็นดชันีท่ีเอาปัจจยัเก่ียวกบัการคาย
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ระเหยของพืชอนัเน่ืองมาจากอณุหภูมิผิวดนิท่ีเพิ่มขึน้หรือลงจะสง่ผลตอ่ปริมาณการคายระเหยของ

พืช เม่ืออุณหภูมิผิวดินเพิ่มสูงขึน้จะท าให้ปากใบของพืชปิดเพ่ือรักษาน า้ในพืชไว้ดงันัน้การคาย

ระเหยจะลดลงตามการเพิ่มขึน้ของอุณหภูมิผิวดินในการศึกษาครัง้นีข้้อดีของการใช้ดชันี NVSWI 

คือมีความเหมาะสมโดยวิเคราะห์จากความสัมพันธ์ของดัชนีความแห้งแล้งกับผลิตภัณฑ์ 

TRMM3B42 โดยมีการพิจารณาถึงพืน้ท่ีชลประทานซึ่งถกูต้องส าหรับการตรวจสอบความแห้งแล้ง   

ส่วนดชันี VHI มีคา่สหสมัพนัธ์เท่ากบั -0.311 แตมี่ความสมัพนัธ์เชิงลบ การวิเคราะห์เชิงพืน้ท่ีผลท่ี

ได้ก็มีความรุนแรงเกินจริงขดัแย้งกบัข้อมูลจากชลประทานเน่ืองจากข้อมลูของอณุหภมูิของผิวดินท่ี

สงู และดชันี NPA จะน าปัจจยัในเร่ืองปริมาณน า้ฝนเข้ามาช่วยในการตรวจสอบความแห้งแล้งและ

มีค่าสัมประสิทธ์ิสหสัมพันธ์เท่ากับ 0.299 ซึ่งหมายความว่าตัวแปรสองตัวมีความสัมพันธ์กัน

เน่ืองจากมีคา่สมัประสิทธ์ิสหสมัพนัธ์เชิงบวก แต่เน่ืองจากดชันีไม่สามารถหาการกระจายเชิงพืน้ท่ี

ได้ จงึได้ผลสรุปวา่ ดชันีท่ีดีท่ีสดุในสามตวัท่ีเหมาะกบัพืน้ท่ีลุม่น า้นา่น คือ ดชันี NVSWI เพ่ือตดิตาม

ความแห้งแล้ง NVSWI มีตวับ่งชีท่ี้ตรงตามวัตถุประสงค์มากกว่า  โดยทั่วไปแล้วNPA ตรวจสอบ

ความแห้งแล้งหลงัจากฝนตกเท่านัน้ซึ่งอาจมีความแตกต่างเล็ก ๆ น้อย ๆ ในบางเดือนท่ีมีฝนตก 

(Shao-E et al., 2014) นอกจากนีร้ะดบัของความแห้งแล้งยงัไม่สามารถตรวจสอบ การกระจายเชิง

พืน้ท่ีของภยัแล้งได้ สว่น VHI เน่ืองจากคา่ของ NDVI และ LST แตกตา่งกนัอยา่งมากในหลายเดือน 

(Kogan, 1998) จงึท าให้ผลท่ีได้มีความแห้งแล้งท่ีเกินจริง และเม่ือดจูากการวิเคราะห์ความสมัพนัธ์

ระหว่างข้อมูล TRMM3B42 และดัชนีทัง้สามพบว่า ดัชนี NVSWI มีความสัมพันธ์กับข้อมูล 

TRMM3B42 มากท่ีสุดและผลการวิเคราะห์เชิงพืน้ท่ีสอดคล้องกบัข้อมูลพืน้ท่ีชลประทานจากกรม

ชลประทาน โดยดัชนี NVSWI ท่ีใช้TRMM ในการประเมินมีความเข้ากันได้กับดัชนี NVSWI ท่ีใช้

ข้อมูลของความชืน้ดินในการตรวจสอบความแห้งแล้งพบว่าได้ผลทีเหมือนกันจึงกล่าวได้ว่า

สามารถใช้ TRMM3B42 ในการตรวจสอบหรือใช้ข้อมูลความชืน้ดินในการตรวจสอบได้(Cong et 

al., 2016) NVSWI ถูกระบุว่าเป็นดชันีท่ีเหมาะสมท่ีสุดในสามดชันีท่ีได้รับการตรวจสอบเพ่ือวัด

ความแห้งแล้งในลุม่น า้นา่น โดยได้มีการศกึษาใช้ VSWI เพ่ือตดิตามความแห้งแล้งหลายการศกึษา 

(Abbas et al., 2014) ซึ่งดจูากวตัถุประสงค์ VSWI มีตวับ่งชีว้ตัถุประสงค์มากกว่า VSWI (Abbas 

et al., 2014) NVSWI เป็นตวัก าหนดความแห้งแล้งโดยเป็นการสร้างดชันีจากการรวมกนัของสภาพ

การเจริญเตบิโตของพืชและอณุหภมูิผิวดนิจงึน าไปสูด่ชันีภยัแล้งท่ีดีท่ีสดุในสามตวั 

 



 
45 

 

  

5.1.3 การกระจายตัวของความแห้งแล้งในลุ่มน า้น่าน 

การกระจายตวัของความแห้งแล้งในลุ่มน า้น่านถกูค านวณจากดชันี NVSWI แสดงให้เห็น

ว่าลุ่มน า้น่านจะประสบปัญหามากในบริเวณทางตอนบนของลุ่มน า้น่านเน่ืองจากมีพืน้ท่ีเป็นภูเขา

และห่างจากเขตพืน้ท่ีชลประทานท าให้ขาดแคลนน า้ได้และเม่ือประสบปัญหาภัยแล้งจึงส่งผล

รุนแรงกว่าพืน้ท่ีอ่ืน ในทางตอนล่างของลุ่มน า้น่านประสบปัญหาภยัแล้งไมรุ่นแรงมากนกัเน่ืองจาก

อยูใ่นพืน้ท่ีชลประทานเม่ือเกิดภยัแล้งจงึมีแหลง่น า้จากชลประทานมาชว่ยบรรเทา 

5.1.4 แนวโน้มการเปล่ียนแปลงความแห้งแล้งในลุ่มน า้น่านในช่วงปี 2551-2560 

 การเปล่ียนแปลงการเกิดภยัแล้งในลุ่มน า้น่านพบว่ามีภยัแล้งสูงท่ีสดุในปี พ.ศ.2554 และ

ภยัแล้งต ่าสดุปี พ.ศ.2558 ในปีอ่ืนก็เกิดภยัแล้งขึน้เป็นปกติแตค่วามรุนแรงท่ีได้รับขึน้อยูก่บัปริมาณ

น า้ฝนและความแปรปรวนของฤดูกาลโดยจะเห็นว่าในลุ่มน า้น่านมีแนวโน้มท่ีจะเกิดภัยแล้งเพิ่ม

สงูขึน้ 

 

5.2 ปัญหาและอุปสรรค 

  เน่ืองจากข้อมูลก่อนน ามาค านวณดชันีภยัแล้งได้ท าการตรวจสอบคณุภาพของข้อมลูท า

ให้ในบางพืน้ท่ีไม่มีข้อมลูเน่ืองจากไม่ผ่านเกณฑ์จึงท าให้การวิเคราะห์เชิงพืน้ท่ีได้ข้อมลูไม่ครบถ้วน 

การโหลดข้อมูลน า้ฝนจากสถานี เน่ืองจากปริมาณข้อมูลท่ีไม่เท่ากันจ านวนปีในแต่ละสถานีไม่

เทา่กนัจงึท าให้การน ามาเปรียบเทียบกนัยาก 

 

5.3 ข้อเสนอแนะ 

 1) ดชันีภัยแล้งมีหลายดชันีขึน้อยู่กับปัจจยัท่ีน ามาพิจารณา งานวิจยัครัง้นีเ้ลือกมาเพียง

สามดัช นี  คือ  Normalized Monthly Precipitation Anomaly Percentage (NPA), Vegetation 

Health Index (VHI) และ  Normalized Vegetation Supply Water Index (NVSWI) หากสนใจ

สามารถหาดชันีภยัแล้งอ่ืนๆเพ่ือมาดคูวามแตกตา่งได้ 

 2) การประเมินความถูกต้องของดัชนีภัยแล้งไม่จ าเป็นท่ีจะต้องใช้เพียงข้อมูลจาก

ผลิตภัณฑ์ TRMM3B42 เท่านัน้สามารถน าข้อมูลความชืน้ดิน หรือปัจจยัอ่ืนท่ีส่งผลต่อความแห้ง

แล้งเข้ามาชว่ยตรวจสอบได้ 

 3) สามารถน างานวิจัยดชันีภัยแล้งในพืน้ท่ี อ่ืนหรือศึกษาผลิตภัณฑ์น า้ฝนท่ีได้จากการ

ประเมินคา่ ซึง่อาจเป็นประโยชน์ตอ่สาธารณะชนตอ่ไป อีกทัง้ยงัเพิ่มประสิทธิภาพของงานวิจยั 
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ภาคผนวก ก. พืน้ท่ีลุ่มน า้ 

ลุม่น า้นา่นมีพืน้ท่ีรวมทัง้สิน้ 34,331 ตารางกิโลเมตร แบง่ออกเป็น 16 ลุม่น า้ย่อย  ตาม

ตารางพืน้ท่ีลุม่น า้ 

รหสั ช่ือลุม่น า้ย่อย พืน้ท่ีรับน า้(ตร.กม.) 

09.02 แมน่ า้นา่นตอนบน 2,265 

09.03 ห้วยน า้ยาว (1) 863 

09.04 แมน่ า้นา่นสว่นท่ี 2 1,501 

09.05 ห้วยน า้ยาว (2) 600 

09.06 น า้สมนุ 620 

09.07 แมน่ า้นา่นสว่นท่ี 3 3,364 

09.08 น า้สา 753 

09.09 น า้ว้า 2,233 

09.10 น า้แหง 1,034 

09.11 แมน่ า้นา่นสว่นท่ี 4 2,613 

09.12 น า้ปาด 2,505 

09.13 คลองตรอน 1,270 

09.14 แมน่ า้แควน้อย 4,490 

09.15 น า้ภาค 987 

09.16 แมน่ า้วงัทอง 2,005 

09.17 แมน่ า้นา่นตอนล่าง 7,228 

รวมพืน้ท่ีทัง้สิน้ 34,331 
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ภาคผนวก ข. สถานีวัดฝนที่ใช้ในการศึกษา 
รหัส ชื่อ แม่น า้ รายละเอียด อ าเภอ จังหวดั ละติจูด ลองจิจูด 

280331 โครงการ
ชลประทาน

นา่น 

 บ้านคา่ไหม
ไชยเจริญ 

อ าเภอเมอืง จงัหวดั
นา่น 

18.77529 100.778 

380111 N.8A แมน่ า้นา่น บางมลูนาก อ าเภอบาง
มลูนาก 

จงัหวดั
พิจิตร 

16.07917 100.4 

390161 N.40 แมน่ า้แคว
น้อย 

บ้านหนอง
บอน 

อ าเภอวดั
โบสถ์ 

จงัหวดั
พิษณโุลก 

17.22056 100.3528 

390220 ศนูย์อทุก
วิทยา 

แมน่ า้นา่น ศนูย์อทุกวยิา อ าเภอเมอืง จงัหวดั
พิษณโุลก 

16.78917 100.2056 

700151 N.12A แมน่ า้นา่น บ้านหาดไผ ่ อ าเภอทา่
ปลา 

จงัหวดั
อตุรดิตถ์ 

17.73611 100.5411 

700221 N.60 แมน่ า้นา่น บ้านเดน่
ส าโรง 

อ าเภอตรอน จงัหวดั
อตุรดิตถ์ 

17.41389 100.1306 

260311 N.67 แมน่ า้นา่น บ้านเกยไชย
เหนือ 

อ าเภอ
ชมุแสง 

จงัหวดั
นครสวรรค์ 

15.86806 100.2686 
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การประเมินความถูกต้องดัชนีภัยแล้งด้วยข้อมูลผลิตภัณฑ์ดาวเทียม:พืน้ท่ีศึกษาลุ่มน า้
น่าน 

Drought Accuracy Assessment of indices from satellite data product: A case study of 
Nan River Basin 

ปาลิดา ดกพฤกษ์1* และ นัฐพล มหาวิค2 
Palida Dokpluk and Nattapon Mahavik 

สาขาภมิูศาสตร์  ภาควชิาทรัพยากรธรรมชาติและสิ่งแวดล้อม 
คณะเกษตรศาสตร์ ทรัพยากรธรรมชาติและสิ่งแวดล้อม มหาวิทยาลัยนเรศวร 

*Corresponding author: Email: Palidad58@email.nu.ac.th 
บทคัดย่อ 

ดัชนีความแห้งแล้งคือดัชนีท่ีบ่งบอกความแห้งแล้งของพืน้ท่ี ได้จากการน าปัจจัยท่ีมี

อิทธิพลส่งผลต่อความแห้งแล้งในพืน้ท่ีนัน้ ในการศกึษาเลือกสามดชันีคือ NVSWI, VHI และ NPA 

และได้ใช้ข้อมูลTRMM3B42 เข้ามาช่วยประเมินความเหมาะสมกบัพืน้ท่ีศกึษาคือลุ่มน า้น่าน โดย

ระยะเวลาท่ีใช้ในการศกึษาคือสิบปี(ปี พ.ศ 2551- ปี พ.ศ 2560) ผลการประเมินจากความสมัพนัธ์

ของข้อมูลTRMM3b42และดัชนีทัง้สามได้ผลสรุปว่า ดัชนี NVSWI มีความสัมพันธ์กับข้อมูล

TRMM3B42มากท่ีสุดโดยมีคา่สมัประสิทธ์ิสหสมัพนัธ์เท่ากับ 0.299และดชันีนีมี้การค านึงถึงน า้ท่ี

อยู่ในพืน้ท่ีลุ่มน า้ด้วยจึงท าให้ผลท่ีได้มาดีท่ีสดุ จึงใช้ดชันี NVSWI มาตรวจดกุารเปล่ียนแปลงของ

ความแห้งแล้งและทราบวา่ภยัแล้งมีแนวโน้มเพิ่มสงูขึน้ 

ค าส าคญั : ภยัแล้ง ดชันีภยัแล้ง ปริมาณน า้ฝน การประเมินความถกูต้อง 

Abstract 

Drought index is an indicator of drought in the area. The factors that influence the 

drought in that area. Three NVSWI, VHI and NPA indexes were used. The data were 

TRMM3B42 To assess the suitability of the study area is Nan. The validity of the 

TRMM3b42 data and the three indexes conclude that the NVSWI has a significant 

relationship with the TRMM3B42 data. Finally, the correlation coefficient is 0.299 and this 

index is based on the waters in the watershed, making it the best result. The NVSWI 

index is used to monitor changes in drought and to know that droughts are likely to 

increase. 

Keywords: drought, drought index, precipitation, precipitation,  Accuracy Assessment  
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1.บทน า 

ภยัแล้งนัน้เป็นปรากฏการณ์ท่ีใช้ระยะเวลาในการท่ีจะทราบถึงผลกระทบท่ีเกิดขึน้โดยจะเร่ิม

ส่งผลจากกการรุกคืบเข้ามาอย่าช้าๆต่างจากปรากฏการณ์อ่ืนท่ีรับรู้ผลกระทบอย่างรวดเร็วโดย 

จากสถานการณ์ภัยแล้งในปี2558 ส่งผลต่อปริมาณน า้ต้นทุนท่ีเก็บกักใน 33 เข่ือนหลักและอ่าง

ต่างๆทั่วประเทศรวมทัง้ปริมาณฝนท่ีตกลงมาน้อยกว่าค่าเฉล่ีย ท าให้หลายพืน้ท่ีจะต้องประสบ

ปัญหาภัยแล้งทัง้ในและนอกเขตชลประทานจากข้อมูลกระทรวงเกษตรและสหกรณ์ส ารวจพบ

ความเสียหายครอบคลมุพืน้ท่ี2.87ล้านไร่เกษตรกรได้รับผลกระทบ 272,743 ราย 

ดชันีความแห้งแล้งคือดชันีท่ีบ่งบอกความแห้งแล้งของพืน้ท่ี ได้จากการน าปัจจยัท่ีมีอิทธิพล

สง่ผลตอ่ความแห้งแล้งในพืน้ท่ีนัน้ การประยกุต์น าเอาข้อมลูผลิตภณัฑ์ดาวเทียมมาชว่ยประเมินหา

ความแห้งแล้งจะเป็นการชว่ยเพิ่มความถกูต้องและแมน่ย ามากขึน้เห็นได้จากงานวิจยัของ Cong et 

al., 2016 ท่ีแสดงให้เห็นว่าการน าเทคโนโลยีการส ารวจระยะไกลและข้อมลูดาวเทียมมาชว่ยในการ

ตรวจสอบความแห้งแล้งนัน้ดีทัง้ในด้านเวลาและการติดตามเชิงพืน้ท่ี เพราะสามารถติดตาม

รูปแบบความแห้งแล้งทัง้ยงัสามารถรับข้อมลูท่ีมีความทนัสมยัเป็นปัจจบุนัสามารถน ามาตรวจสอบ

ได้จากข้อมลูส านกังานทรัพยากรน า้ภาค9ได้อธิบายว่าลุ่มน า้น่านเป็นลุ่มน า้หลกัในภาคเหนือของ

ประเทศไทยโดยลุม่น า้นา่นได้ครอบคลมุบางส่วนของ5จงัหวดัคือ จงัหวดัน่าน  อตุรดิตถ์  พิษณโุลก  

พิจิตร และนครสวรรค์ ในสาขาลุ่มแม่น า้น่านตอนล่างนิยมท าการเกษตรมากโดยเฉพาะพืน้ท่ี

จังหวัดพิจิตรและจังหวัดพิษณุโลก โดยในประชากรบริเวณลุ่มน า้มีประมาณ 2.15 ล้านคนในปี

2547 แม่น า้ในลุ่มน า้น่านบางส่วนจะไหลลงผ่านหุบเขาลงสู่อ่างเก็บน า้สิริกิติ์ แม่น า้ในลุ่มน า้น่าน

นัน้มีความส าคัญต่อผู้คนท่ีด ารงชีวิตอยู่ไม่ว่าจะน าไปอุปโภคหรือบริโภคร่วมถึงการน าไปใช้ใน

การเกษตร  จากการศกึษาและทบทวนรายงานโครงการจดัท าแผนการบริหารจดัการทรัพยากรน า้

ในพืน้ท่ีลุ่มน า้น่าน พบว่า ปัญหาการขาดแคลนน า้และภัยแล้งในเขตพืน้ท่ีลุ่มน า้น่านเป็นปัญหาท่ี

เกิดจากสภาพดินฟ้าอากาศ ส่วนใหญ่เกิดจากภาวะฝนทิง้ช่วงเป็นเวลายาวนานส่งผลกระทบต่อ

พืน้ท่ีการเกษตรนอกเขตชลประทาน ซึ่งการเพาะปลูกในพืน้ท่ีเหล่านี ้ส่วนใหญ่จะท ากันในฤดฝูน

และใช้น า้ฝนเป็นหลกั ยกเว้นบางพืน้ท่ีติดล าน า้หรือติดโครงการพฒันาแหล่งน า้ขนาดเล็ก ปัญหา

การขาดแคลนน า้และภัยแล้ง ในพืน้ท่ีเพาะปลูกอ่ืนๆ นอกเขตชลประทานจะขึน้อยู่กับปริมาณฝน

และความสม ่าเสมอในแตล่ะปี 
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การศึกษาครัง้นีจ้ึงมีวตัถปุระสงค์เพ่ือประเมินความถูกต้องของดชันีภัยแล้งโดยน าเทคโนโลยี

การส ารวจระยะไกลและข้อมูลผลิตภัณฑ์ดาวเทียม TRMM3B42 V.7 มาช่วยตรวจสอบเพ่ือความ

ถกูต้องและแมน่ย าของข้อมลูเพื่อให้การวางแผนรับมือภยัแล้งมีประสิทธิภาพมากขึน้ 

2.ข้อมูลและกระบวนการ 

2.1 พืน้ท่ีศกึษา 

ลุม่น า้นา่นประกอบไปด้วย 5 จงัหวดั ได้แก่ นา่น อตุรดติถ์ พิจิตร พิษณโุลก และนครสวรรค์  

มีพืน้ท่ีรวมทัง้สิน้ 34,331 ตารางกิโลเมตร ลกัษณะของลุ่มน า้จะวางตวัตามแนวทิศเหนือ-ใต้  แมน่ า้

นา่นมีต้นก าเนิดมาจากเทือกเขาหลวงพระบาง มีความสงูอยูท่ี่ระดบั 220 ม.จากระดบัน า้ทะเลปาน

กลาง ปัญหาภยัแล้งท่ีเกิดในลุ่มน า้น่านเกิดจากภาวะฝนทิง้ช่วงยาวนานท าให้พืน้ท่ีการเกษตรท่ีอยู่

นอกเขตชลประทานเกิดความแห้งแล้งขาดแคลนน า้เพ่ือการอปุโภค-บริโภค และการเกษตร รวมทัง้

การใช้น า้ในกิจกรรมอ่ืนๆ ลุม่น า้นา่นมีปริมาณฝนทัง้ปีเฉล่ียประมาณ  1,272.7 มิลลิเมตร

2.2 สภาพภมูิอากาศ 

พืน้ท่ีลุ่มน า้น่านอยู่ภายใต้อิทธิพลของลมมรสมุตะวนัตกเฉียงใต้และตะวนัออกเฉียงเหนือ

นอกจากนีย้งัมีพายดีุเปรสชัน่และพายไุต้ฝุ่ นซึง่มาจากทะเลจีนใต้พดัผา่นเข้ามาเป็นครัง้คราว สง่ผล

ท าให้เกิดฤดกูาลต่างๆได้แก่ฤดฝูนจะเกิดในช่วงเดือนพฤษภาคมถึงเดือนตลุาคมฤดหูนาวจะเกิด

ในช่วงปลายเดือนตุลาคมถึงเดือนกุมภาพันธ์และฤดูร้อนจะเกิดในช่วงเดือนมีนาคมถึงเดือน

เมษายน 

2.3 การเก็บข้อมลูและประมวลผล 

2.3.1. ผลิตภณัฑ์ MODIS NDVI และ LST 

NDVI และ LST เป็นผลิตภัณฑ์ท่ีได้จากผลิตภัณฑ์ดาวเทียม MODIS (MOD13c2 และ

MOD11c3 ตามล าดับ) ในการศึกษาครัง้นีใ้ช้ข้อมูลตัง้แต่ปี พ.ศ. 2551-พ.ศ.2560 จากระบบ

สังเกตการณ์ของนาซ่า และระบบข้อมูลสารสนเทศ  (https://search.earthdata.nasa.gov) 

ผลิตภณัฑ์ทัง้สองมีระยะเวลา 30 วนั (รายเดือน)และความละเอียดเชิงพืน้ท่ี 0.05 ° 

2.3.2 ผลิตภณัฑ์ TRMM3B42 

ในการศึกษาครัง้นีใ้ช้ผลิตภัณฑ์TRMM3B42  V.7 ตัง้แต่เดือนมกราคมถึงเดือนธันวาคม 

พ.ศ.2551-พ.ศ.2560 ได้จากระบบสัง เกตการณ์ของนาซ่า และระบบข้อมูลสารสนเทศ

(https://mirador. gsfc.nasa.gov) ผลิตภัณฑ์ TRMM3B42 v.7 ใช้ในการค านวณดชันี NPA และ



 
56 

 

  

ตรวจสอบคุณภาพจากข้อมูลปริมาณน า้ฝนจากสถานี ความละเอียดขนาด 0.25°x0.25° และ

ปริมาณฝนรายวนั 

2.3.3 ข้อมลูปริมาณน า้ฝนจากสถานีวดัฝน 

ข้อมลูปริมาณน า้ฝนจากสถานีตรวจวดัฝน คือ ข้อมลูปริมาณน า้ฝนท่ีได้รับมาจากปี พ. ศ. 

2551 ถึ ง ปี พ . ศ . 2560 จ า น ว น 7ส ถ า นี จ า ก ร ะ บ บบ ริ ก า ร ข้ อ มู ล ท า ง อุ ตุ นิ ย ม วิ ท ย า 

(https://www.tmd.go.th/) เพ่ือตรวจสอบขอมลู TRMM 3B42 รายเดือน ข้อมลูในลุม่น า้น่านซึง่เป็น

ค่าเฉล่ียรายเดือนของข้อมูลท่ีรวบรวมได้จากสถานีอุตุนิยมวิทยา ภายในลุ่มน า้น่านในและพืน้ท่ี

โดยรอบน ามาเฉล่ียเป็นรายเดือน 

 
ภาพ 1 ขอบเขตพืน้ท่ีศึกษาลุ่มน า้น่าน 
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ภาพ 2 ปริมาณน า้ฝนรายปี พ.ศ. 2551-พ.ศ.2560

2.3.4 ข้อมลูการใช้ประโยชน์ท่ีดนิ 

ข้อมลูการใช้ประโยชน์ท่ีดิน คือ ข้อมลูท่ีแสดงถึงสิ่งท่ีปกคลมุพืน้ผิว ข้อมลูได้จากกรมท่ีดิน

โดยถกูน ามาใช้เพ่ือให้ทราบถึงประเภทของการใช้ประโยชน์ท่ีดินในแต่ละพืน้ท่ีโดยใช้ข้อมลู ปีพ.ศ. 

2551 ถึงปี พ.ศ. 2560 

 

2.4 กระบวนการ 

 ขัน้ตอนในการศกึษาแสดงในแผนผงัตามภาพ 3 โดยมีขัน้ตอนทัง้หมดส่ีขัน้ตอนตอ่ไปนี ้(1) 

ท าการตรวจสอบและประมวลผลของข้อมูลก่อนเพ่ือให้ได้ดชันี VHI และ NVSWI หลงัจากนัน้ใช้

ผลิตภณัฑ์ TRMM3b42 ซึง่น ามาตรวจสอบกบัข้อมลูปริมาณน า้ฝนจากสถานีน า้ฝนแล้วจงึน ามาใช้

ค านวณดัชนี  NPA (2) ตรวจสอบดัชนีทัง้สามดัชนีท่ีได้จากปัจจัยท่ีแตกต่างกัน วิ เคราะห์

ความสัมพันธ์ทัง้สามดัชนีกับข้อมูลฝน(3) ดัชนีภัยแล้งท่ีดีท่ีสุดถูกเลือก และน ามาวิเคราะห์

ความสมัพนัธ์ (4) การกระจายตวัของภยัแล้งและแนวโน้มการเปล่ียนแปลงท่ีเกิดขึน้ 

2.4.1 NPA 

เปอร์เซ็นต์ปริมาณน า้ฝนตอ่เดือน (PA) หมายถึงปริมาณน า้ฝนลดลงเม่ือเทียบกบัคา่เฉล่ีย

ของชว่งเวลาเดียวกนั มนัคือค านวณโดยใช้สตูรตอ่ไปนี ้(Shao-E และ Bing-Fang, 2010) 

                             



P P

PA * 100%
P                                   (สมการท่ี 1) 

โดยท่ี P หมายถึงปริมาณน า้ฝนในปัจจบุนั P คือปริมาณน า้ฝนท่ีอยูใ่นชว่งเวลาเดียวกนั PA 

สามารถใช้เพ่ือติดตามความแห้งแล้งได้ในระดบัหนึ่งค่าเบี่ยงเบนเทียบกับปริมาณน า้ฝนเฉล่ีย ค่า
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ของ PA สามารถเป็นบวกหรือลบ เปอร์เซ็นต์ความผิดปกติของฝนท่ีมีค่าต่อเดือน(NPA) ท่ีมีค่า

ตัง้แต ่0 ถึง 1 หาได้จาก 

                          





min

max min

PA PA
NPA

PA PA                                 (สมการท่ี 2) 

ท่ี PA min และ PA max เป็นคา่ต ่าสดุและสงูสดุของNPA ตามล าดบั 

2.4.2 VHI 

 สามารถใช้ข้อมูล NDVI และ LST ได้สร้างดชันีส าหรับการตรวจสอบความแห้งแล้ง VCI 

แสดงให้เห็นถึงภาวะปกติของค่า NDVI เทียบกับสัมบูรณ์สูงสุดและต ่าสุดของNDVI TCI ใช้ค่า

ความสว่างเพ่ือประเมินความแห้งแล้งแทนของระดบัอุณหภูมิของพืชพืช ค่า VHI ค านวณโดยการ

รวม VCI และ TCI ค านวณ VCI, TCI และ VHI ด้วยสตูรตอ่ไปนี ้(Kogan, 1998) 

                                






min

max min

NDVI NDVI
VCI

NDVI NDVI     (สมการท่ี 3) 

                                    





min

max min

LST LST
TCI

LST LST                                     (สมการท่ี 4) 

                                          VHI a * VCI b * TCI                                        (สมการท่ี 5) 

NDVImin และ NDVImax เป็นค่าต ่าสุดและสูงสุดของNDVI ตามล าดับ ส่วน LSTmin และ 

LSTmax มีคา่ต ่าสดุและสงูสดุ คา่ LST ตามล าดบั a และ b เป็นคา่สมัประสิทธ์ิน า้หนกัของ VCIและ 

TCI เน่ืองจากมีส่วนร่วมของความชืน้และอุณหภูมิในช่วงพืชท่ีไม่ทราบแน่ชดัจึงต้องสมมติว่าค่า

ของ VCI และ TCI เท่ากับ (a = b = 0.5) VHI ของการศึกษาพืน้ท่ีตัง้แต่เดือนมกราคมถึงเดือน

ธนัวาคมของชว่งเวลาทัง้หมด พ.ศ. 2551-พ.ศ.2560 

2.4.3 NVSWI 

เม่ือพืชต้องประสบกบัภยัแล้งโดยท่ีไม่มีน า้จะท าให้ปากใบปิดเพ่ือรักษาน า้ในพืชไว้ ดงันัน้

การคายระเหยจะลดลงตามการเพิ่มขึน้ของ LST จะสังเกตเห็นได้จากพืชท่ีลดลงเน่ืองจากมีการ

คายระเหยจากพืน้ดนิท่ีน้อยลง NVSWI ถกูสร้างขึน้และมีสตูรดงันี(้Carlson et al., 1994) 

                                         
NDVI

VSWI
LST                                        (สมการท่ี 6) 
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เน่ืองจาก VSWI สามารถแสดงต าแหน่งเชิงสมัพทัธ์ได้และไม่สามารถเทียบได้กบัชดุข้อมลู

เวลา NVSWI จงึถกูน ามาใช้และค านวณโดยใช้สตูรตอ่ไปนี ้(Abbaset al., 2014) 

                                   





min

max min

VSWI VSWI
NVSWI

VSWI VSWI                              (สมการท่ี 7) 

ท่ี VSWImin และ VSWImax เป็นคา่ต ่าสดุและสงูสดุของ VSWI ในชว่งระยะเวลาการศกึษาตามล าดบั

ค านวณจากชว่งเดือนมกราคม - ธนัวาคมของพ.ศ. 2551-พ.ศ.2560ในพืน้ท่ีศกึษาลุม่น า้นา่น  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

ภาพ 3 ขัน้ตอนการตรวจสอบความแห้งแล้ง 
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2.4.4การตรวจสอบข้อมลู TRMM3B42 V.7 

ในการตรวจสอบจะใช้ข้อมูลปริมาณน า้ฝนจากสถานีเข้ามาช่วยตรวจสอบ โดยได้น าต า

แหนท่ีตัง้ของสถานีฝนมาช่วยในการดึงข้อมูลน า้ฝนออกมาจาก TRMM3B42 V.7 และใช้การ

วิเคราะห์การถดถอยเชิงเส้น ค่าสมัประสิทธ์ิสหสมัพนัธ์ (R) และค่าความผิดพลาดหลกัรูท Mean 

Square(RMSE) ถูกค านวณเพ่ือวดัความสม ่าเสมอและความคลาดเคล่ือนระหว่างข้อมูลปริมาณ

น า้ฝน TRMM3B42 V.7 และการวดัจากสถานี 

3.ผลการศึกษา 

3.1การตรวจสอบความถกูต้องผลิตภณัฑ์ TRMM3B42  V.7  กบัข้อมลูจากสถานีฝน 

การตรวจสอบความถูกต้องของผลิตภัณฑ์การตกตะกอนTRMM3B42ประจ าเดือนท่ีมีอยู่

ข้อมลูปริมาณน า้ฝนในการศกึษานีผ้ลิตภณัฑ์การตกตะกอนของ TRMM3B42แสดงให้เห็นถึงความ

สอดคล้องกนักนัชัว่คราวภายในข้อมลูในสถานีแม้วา่จะมีการประเมินเกินในชว่งฤดฝูนและบางครัง้

อาจมีการประเมินต ่าเกินไป 

 

 

 

 

 

 

 

 

 

 

ภาพ 4 แสดงปริมาณน า้ฝนในปีพ.ศ.2553ของ TRMM3B42 และจากสถานีฝน                                         

โดยข้อมลูชดุท่ี1คือข้อมลูขากTRMM และข้อมลูชดุท่ีสองคือจากสถานีฝน 

 3.2การประเมินดชันีความแห้งแล้ง 

 เพ่ือเลือกดชันีความแห้งแล้งท่ีเหมาะสมท่ีสดุในลุ่มน า้น่านการแสดงผลของดชันีท่ีใช้กันอยู่

สามตัว (NPA, VHI และNVSWI)ได้รับการประเมินจากการวิ เคราะห์ความสัมพันธ์โดยใช้  
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TRMM3B42 เพ่ือศึกษาความแห้งแล้งในรายละเอียดทัง้สามดัชนี NVSWI, VHI และ NPA แบ่ง

ออกเป็นระดบั:ความแห้งแล้งปานกลางแล้งแล้งแห้งแล้งสภาพปกติและความเปียก ระดับเหล่านี ้

สอดคล้องกับช่วงตวัเลขของ 0-0.2,0.2-0.4, 0.4-0.6, 0.6-0.8 และ 0.8-1 ตามล าดบั จากผลการ

วิเคราะห์ความสัมพันธ์ของดชันีภัยแล้งและ TRMM3B42 แล้วพบว่า NVSWI มีความสอดคล้อง

มากกว่าดชันีตวัอ่ืนเน่ืองจากผลท่ีออกมามีการค านึงถึงการอยู่ใกล้ไกลของแหล่งน า้โดย (Cong et 

al., 2016) NVSWI ถูกระบุว่าเป็นดชันีท่ีเหมาะสมท่ีสุดในสามดชันีในการศึกษาครัง้นีไ้ด้ใช้ VSWI 

เพ่ือตดิตามความแห้งแล้ง NVSWI มีตวับง่ชีว้ตัถปุระสงค์มากกวา่ VSWI โดย NPA ตรวจสอบความ

แห้งแล้งหลงัจากฝนตกเทา่นัน้ซึง่อาจมีความแตกตา่งเล็ก ๆ น้อยในบางเดือนท่ีมีฝนตกนัน้ๆ  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพ 5 การกระจายตวัเชิงพืน้ท่ีของภยัแล้งในปี พ.ส.2553 

4. อภปิรายผล 

           ดัชนีท่ีมีความสัมพันธ์กับข้อมูลดังกล่าวมากท่ีสุด คือดัชนี NVSWI โดยมีค่าสหสัมพันธ์

เทา่กบั 0.792 มีความสมัพนัธ์เชิงบวกและจากการวิเคราะห์เชิงพืน้ท่ีพบว่าสอดคล้องกบัข้อมลูพืน้ท่ี

ชลประทาน เป็นดชันีท่ีเอาปัจจัยเก่ียวกับการคายระเหยของพืชอันเน่ืองมาจากอุณหภูมิผิวดินท่ี
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เพิ่มขึน้หรือลงจะส่งผลตอ่ปริมาณการคายระเหยของพืช เม่ืออณุหภูมิผิวดินเพิ่มสงูขึน้จะท าให้ปาก

ใบของพืชปิดเพ่ือรักษาน า้ในพืชไว้ดงันัน้การคายระเหยจะลดลงตามการเพิ่มขึน้ของอณุหภมูิผิวดิน

ในการศกึษาครัง้นีข้้อดีของการใช้ดชันี NVSWI คือมีความเหมาะสมโดยวิเคราะห์จากความสมัพนัธ์

ของดัชนีความแห้งแล้งกับผลิตภัณฑ์ TRMM3B42 โดยมีการพิจารณาถึงพืน้ท่ีชลประทานซึ่ง

ถูกต้อง ส่วนดชันี VHI มีค่าสหสมัพนัธ์เท่ากับ -0.311 แต่มีความสมัพนัธ์เชิงลบ การวิเคราะห์เชิง

พืน้ท่ีผลท่ีได้ก็มีความรุนแรงเกินจริงขดัแย้งกับข้อมูลจากชลประทานเน่ืองจากข้อมลูของอุณหภูมิ

ของผิวดินท่ีสงู และดชันี NPA จะน าปัจจยัในเร่ืองปริมาณน า้ฝนเข้ามาช่วยในการตรวจสอบความ

แห้งแล้งและมีคา่สมัประสิทธ์ิสหสมัพนัธ์เท่ากบั 0.299 ซึ่งหมายความตวัแปรสองตวัมีความสมัพนัธ์

กันเน่ืองจากมีค่าสมัประสิทธ์ิสหสมัพนัธ์เชิงบวก แต่เน่ืองจากดชันีไม่สามารถหาการกระจายเชิง

พืน้ท่ีได้ จงึได้ผลสรุปวา่ ดชันีท่ีดีท่ีสดุในสามตวัท่ีเหมาะกบัพืน้ท่ีลุม่น า้น่าน คือ ดชันี NVSWI 

5.สรุปผล 
           การประยกุต์ใช้ดชันีความแห้งแล้งท่ีใช้กนัอย่างแพร่หลายสามแห่ง (NPA, VHI และNVSWI) 

ได้รับการประเมินจากการวิเคราะห์ความสมัพนัธ์ระหว่าง TRMM3B42 และดชันีความแห้งแล้งใน

สามเขตภูมิอากาศ  ในฤดูแล้งการกระจายตวัของความแห้งแล้งในฤดูแล้งพบว่าความแห้งแล้ง

เกิดขึน้ได้ง่ายมากกว่า พืน้ท่ีส่วนใหญ่จะประสบปัญหาภัยแล้งในฤดูหนาวและในฤดูแล้งการ

กระจายตัวของความแห้งแล้งในฤดูแล้งพบว่าความแห้งแล้งเกิดขึน้ได้ง่ายกว่าแนวโน้มการ

เปล่ียนแปลงของความแห้งแล้งจากปี พ.ศ. 2551-พ.ศ.2560มีแนวโน้มเพิ่มสูงขึน้ NVSWI เป็น

ตวัก าหนดความแห้งแล้งโดยเป็นการสร้างดชันีจากการรวมกันของสภาพการเจริญเติบโตของพืช

และอณุหภมูิผิวดนิจงึน าไปสูด่ชันีภยัแล้งท่ีดีท่ีสดุในสามตวั 

6. กิตตกิรรมประกาศ 

         ขอขอบคุณ กรมอุตุนิยมวิทยาท่ีให้ข้อมูลปริมาณน า้ฝน กรมพัฒนาท่ีดินท่ีให้ข้อมูลการใช้

ประโยชน์ท่ีดินในลุ่มน า้น่าน กรมชลประทานท่ีให้ข้อมูลขอลุ่มน า้น่าน และศูนย์อุทกวิทยา

ชลประทานท่ีให้ข้อมลูพืน้ท่ีชลประทาน ส าหรับการเอือ้เฟือ้ส าหรับข้อมลูท่ีน ามาใช้ในงานวิจยันี ้จน
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